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EMC Information

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE 
STATEMENT

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.

FCC Caution: Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to operate this equipment.

Warning: Operation of this equipment in a residential environment could cause radio 
interference.

KCC Statement
유선 제품용 / A급 기기 (업무용 방송 통신 기기 ) 
이 기기는 업무용 (A급 ) 전자파적합기기로서 판매자 또는 사용자는 이
점을 주의하시기 바라며 , 가정 외의 지역에서 사용하는 것을 목적으로 
합니다 .

RoHS

This product is RoHS compliant.

Safety

This product has been classified as Information Technology Equipment.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://eservice.aten.com 

International 886-2-8692-6959

China 86-400-810-0-810

Japan 81-3-5615-5811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988
1-949-428-1111
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Package Contents

VK0100
The VK0100 package consists of:

1 VK0100 8-Button Control Pad (US, 1 Gang)
1 Button Pack
6 Terminal Blocks
1 Faceplate
1 User Instructions*

VK0200
The VK0200 package consists of:

1 VK0200 12-Button Control Pad (EU, 2 Gang)
1 Button Pack
6 Terminal Blocks
1 Faceplate
1 User Instructions*

VK1100
The VK1100 package consists of:

1 VK1100 Compact Control Box
4 Terminal Blocks
1 Power Cord
1 User Instructions*

VK2100
The VK2100 package consists of:

1 VK2100 Control Box
1 Rack Mount Kit
9 Terminal Blocks
1 Power Cord
1 User Instructions*
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Note:
Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the ATEN controller and 
other connected devices.
The VK2100 product firmware may have been updated with new features 
after the release of this manual. For an up-to-date VK2100 user manual, 
visit http://www.aten.com/global/en/

http://www.aten.com/global/en/
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About this Manual

This user manual is provided to help you get the most from your ATEN Control 
System. It covers all aspects of installation, configuration, and operation of the 
ATEN controllers and their accessories, including:

An overview of the information found in the manual is provided below.

Chapter 1, Introduction
Introduces you to the ATEN Control System. Its purpose, features, and benefits 
are presented, and panel components of the Control Box and Control Pad are 
described.

Chapter 2, Hardware Setup
Provides the necessary steps to setup the ATEN Control System installation, 
including how to wire the different types of hardware connections.

Chapter 3, Browser Operation
Provides information on Control Box and Control Pad’s web interface and how 
to use it to remotely configure parts of the ATEN Control System installation.

Chapter 4, ATEN Configurator (VK6000)
Provides a complete description of the ATEN Configurator (VK6000) software 
and how to use it to configure and operate the ATEN Control System.

Chapter 5, ATEN Database Generator
Provides a complete description of the Database Generator software and how 
to use it to configure new devices to add to the VK6000 device library.

Device Category Device Model Device Name

ATEN Control Box VK1100 ATEN Compact Control Box

VK2100 ATEN Control Box

ATEN Control Pad VK0100 8-Button Control Pad (US, 1 Gang)

VK0200 12-Button Control Pad (EU, 2 Gang)

ATEN Keypad VK108US 8-Button Keypad (US, 1 Gang)

VK112EU 12-Button Keypad (EU, 2 Gang)

ATEN Extension Box VK224 4-Port Serial Expansion

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box
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Chapter 6, Remote PC Control
Explains how to set up your computer for remote control from a licensed 
device and provide a complete description of the supported control actions.

Chapter 7, ATEN Control System App
Provides a complete description of the ATEN mobile app and how to use it to 
operate devices connected to the ATEN Control System.

An Appendix
Provides specifications and other technical information regarding the ATEN 
Control System.

Conventions

This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to 
press the Enter key. If keys need to be chorded, they appear 
together in the same bracket with a plus sign between them: 
[Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run means to 
open the Start menu, and then select Run.

Indicates critical information.
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Terminology

Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized 
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

Terminology Description

Control Box The term is used to refer to all models of ATEN Control Box, 
including the VK2100 Control Box and the VK1100 Compact 
Control Box.

controller The term is used to refer to all models of ATEN Control Box 
(VK1100 and VK2100) and ATEN Control Pad (VK0100 and 
VK0200).

Viewer or profile A Viewer or profile is a software interface created using ATEN 
Configurator to be used on mobile devices to control devices 
managed by controllers.

project A project is a set of settings created using ATEN Configurator to 
specify how devices are to be managed by ATEN controllers.

International http://www.aten.com

North America http://www.aten-usa.com
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Chapter 1
Introduction

Overview

The ATEN Control System, incorporating the ATEN Control Box/ATEN 
Control Pad (controller), the ATEN Configurator software (VK6000), and the 
ATEN Control System App is a standard Ethernet-based management system 
that connects all hardware devices in a room or large facility to provide 
centralized control of devices directly and effortlessly via a mobile device. The 
ATEN controller works as the main controller that provides great connectivity 
to all sorts of hardware devices commonly seen in a room. After connecting the 
hardware, the ATEN Configurator (VK6000) provides simple setup of the 
devices with easy step by step configuration. The ATEN Control System App 
then connects you to the controller from any iOS, Android or Windows mobile 
device / tablet computer which empowers you with mobility to control all the 
hardware devices, in different rooms, whenever and however you like.

ATEN Control Box/Control Pad easily deploys into an existing installation and 
integrates seamlessly with ATEN VanCryst pro-AV products and nearly any 
other hardware devices found in a room, including AV equipment, lighting, 
conference systems, air conditioning, motion sensors, power switches and 
many more. The controller serves as the central platform where hardware 
devices are connected – to be monitored, managed, and controlled directly via 
a tailor-made GUI from any iOS, Android, or Windows mobile device.

The VK6000 Configurator software facilitates quick setup and control of the 
devices in a few easy steps via an intuitive GUI. The VK6000 walks you 
through configuring the hardware, designing the interface and uploading 
Profiles to the controller. To provide control of the hardware devices, Profiles, 
which contain Viewers, are imported via the ATEN Control System App from 
any iOS, Android or Windows mobile device. Through an Ethernet connection, 
the ATEN Control System App enables you to import and update Profiles from 
the controller via a point-n-tap user interface. Each Viewer is a customized 
control interface that grants you quick access to target and control hardware 
devices. Use of any profile is protected with password authentication to ensure 
secure access.
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The ATEN Control System is perfectly applicable in meeting rooms, 
conference centers, boardrooms, classrooms or any room that requires central 
and mobile control of a variety of hardware devices through a streamlined 
management system with optimum efficiency and performance.
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Benefits

Intelligent Control
The ATEN Control System makes the interactions between your hardware 
devices smarter. Pre-programmed actions and triggers can provide a fully 
automated series of advanced operations that allow your devices to respond to 
each other intelligently, making your whole solution run smarter and smoother.

Optimized Performance
The ATEN Control System has optimized the communication protocols that 
not only maintain a near-zero response time but also feature data encryption for 
extra protection.

Simplified Setup
No matter how large the room or how complicated the hardware, the ATEN 
Control System can be deployed in 3 easy steps: connect the hardware, 
configure the system and upload profiles via a smart mobile app. Through an 
intuitive GUI, the process for setting up the controls for every room is simple 
and customizable, via straightforward predefined commands and macros, that 
do not require you to have complicated programming skills.

Effortless Expandability
With a range of expansion boxes available, the ATEN Control System 
installation can grow to accommodate additional Serial, Relay and IR devices. 
Furthermore, the ATEN Library has 10,000+ device drivers and grows as you 
add new devices to the existing database via the Database Generator, making 
it expandable and easily manageable, whatever the size or scope of the 
installation.

User Centered Convenience
An advanced, single-software solution creates an intuitive interface for any 
mobile device, while specific needs are customizable by selecting from an 
extensive library of actions and design elements to customize the control panel. 
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In addition, the ATEN Control System provides various support services that 
include driver downloads, database generation and upgrade tools – to help 
system integrators build easy-to-control environments effortlessly.

On-the-Go Control
Intuitive system control can start with one room and scale up to multiple rooms 
in the same area or across regions. Toggling between profiles on an iOS, 
Android or Windows mobile device facilitates control of different rooms with 
simple point-n-tap operations. In addition, multiple mobile devices can be 
authorized with access to control the same room or multiple rooms, providing 
you with flexible, enhanced mobility, and tight security.
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Features

ATEN Control Box
Supports various connection interfaces:

DC outputs for power supply connections
VK2100: equipped with 4 DC outputs
VK1100: equipped with 1 DC output

1 x USB port for easy profile upload
IR Learning function for adding IR device drivers
Supports native KNX IP for building management systems
Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
Supports project file backup
Supports up to 8 ATEN Keypads
Web GUI for easy system configuration
2 free licenses for mobile control*
Supports SSH communication for data monitoring
Rack-mountable

Note: If you need more than two licenses for mobile control, contact your 
local sales representative. 

Interface VK2100 Control Box VK1100 Compact Control Box

Serial Port 6 2

IR/Serial Port 4 2

Relay Channel 4 4

I/O Channel 4 -

Ethernet Port 1 1
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ATEN Control Pad
Supports various connection interfaces:

2 RS-232 serial ports
2 relay channels
1 digital input port
1 Ethernet port

Designed to mount in 2-gang EU type and MK type junction boxes (for 
VK0200)
Fully customizable layout

VK0100: 14 layout variations using 4 to 8 buttons
VK0200: 125 layout variations using 6 to 12 buttons

Customizable button text engraving service
System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments
Redundant power supplies (DC power and PoE)
Supports native KNX IP for building management systems
Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
Supports project file backup
Web GUI for easy system configuration
Supports SSH communication for data monitoring

Note: To control your setup using a mobile device, contact your local sales 
representative to purchase licenses for mobile control. 
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ATEN Configurator
Simple profile setup with easy configuration steps via intuitive GUI
Customizable GUI to be used on mobile devices and PC
Supports ControlAssist that allows PC control (PC shutdown, media files, 
PowerPoint files)*
Built-in Database Generator for device driver setup and overall device 
management.
Built-in ATEN Library comprising 10,000+ device drivers and complete 
ATEN VanCryst product drivers
Event scheduling
Two-way communication enables user-defined event monitoring to 
automatically trigger the next actions
Test tool to verify commands in action before uploading the profile to the 
ATEN controller
Simulator to simulate and review the customized GUI before uploading

Note: For details on the supported PC control actions, see Supported PC 
Control Actions, page 168. 

ATEN Control System App
Allows administrators central control of multiple rooms via profiles on a 
mobile device or tablet computer
Restrict user access to profiles via password authentication
Synchronization of system controls amongst multiple mobile devices and 
tablet computers
Any iOS, Android, or Windows mobile device can be used to control the 
system – no need to purchase costly
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ATEN Keypads
Fully customizable layout

VK108US: 14 layout variations using 4 to 8 buttons
VK112EU: 125 layout variations using 6 to 12 buttons

System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments
Easy ID pairing with ATEN controller for Ethernet communication
Scalability – an ATEN controller can connect up to 8 Keypads
Versatile modes support flexible behavior settings for each button
Intuitive Web GUI for easy configuration
Redundant power supplies (DC power and PoE)
Button engraving service
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Requirements

Prepare the following equipment and make sure your equipment meets the 
minimum requirements specified below.

Hardware devices to be controlled by your ATEN controller
Bi-directional RS-232/422/485 serial devices
One-way IR or serial transmitter hardware devices (for Control Box 
only)
Relay hardware devices
Digital input hardware devices (for VK2100 and Control Pad only)
Digital output hardware devices (for VK2100 only)
Ethernet-controlled PJLink, Telnet, ONVIF, TCP, UDP, HTTP, or 
HTTPS devices
KNX IP interfaces for connecting KNX-compliant devices

Cables
One Cat 5e/6 Ethernet cable used to connect the ATEN controller to 
the local area network
(Optional) For serial devices with DB9 connectors, use standard 
straight-through cables.

A computer for configuring your ATEN Control System 
Make sure the computer runs Windows 7, 8, 8.1, 10, or any of the later 
versions.

(Optional) Up to 10 mobile devices for remote control

Note: A license is required for each mobile device. For detailed 
information, see Licenses for Mobile Control, page 57.
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Accessories

Optionally purchase ATEN accessories to enhance the functionality of your 
Control System. For more information, visit the ATEN website. Contact your 
ATEN dealer to purchase these accessories.

Model Description

2XRT-0004G Full Range IR Emitter (1.8 m)

2X-031G Single Rack Mount Kit for VK1100

VK108US 8-button Keypad (US, 1 Gang)

VK112EU 12-button Keypad (EU, 2 Gang)

VK224 4-Port Serial Expansion Box

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box

SA0141 DB9-F to RJ45-F Adapter

SA0145 RJ45-F to DB9-M Adapter
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Chapter 2
Hardware Setup

ATEN Control Box

Panel Components

VK2100 Front View

No. Component Description

1 Relay LED The LED lights green to indicate an active device connection 
(closed loop).

2 IR/Serial LED The LED lights green to indicate an active device connection 
and IR/Serial signals are being transmitted.

3 I/O LED The LED lights green to indicate an active device connection 
and I/O signals are being transmitted.

4 Serial LED The LED (1~6) lights green to indicate serial signals are 
being transmitted.

1. Important safety information regarding the placement of this 
device is provided on Safety Instructions, page 187. Please 
review it before proceeding.

2. Make sure that the power to all devices connected to the 
installation are turned off. You must unplug the power cords of 
any computers that have the Keyboard Power On function.

1 1052 43 6 7 8 9
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5 Ethernet LED The LEDs provide information about the network 
connection:

Link: The LED blinks green to indicate Ethernet signals 
are being transmitted.

ACT: The LED lights green to indicate 100Mbps transmis-
sions.

6 DC Overload LED The LED lights orange to indicate DC output exceeds 
maximum output.

Note: When the LED lights orange, please unplug any of the 
connected devices to keep its total output under 24W.

7 IR Receiver / LED This IR receiver passes the functions of a remote control to 
the VK2100 in learning mode. The distance between the IR 
remote and the receiver window should be kept under 10cm 
with a direct line of sight.

The LED blinks green to indicate the unit is ready to 
receive signals from an IR remote control.

8 USB Port / LED This is where a USB device plugs in to upload Viewer files to 
the VK2100.

The LED blinks green to indicate Viewer files are being 
uploaded, and lights green to indicate a successful upload 
of Viewer files.

The LED lights orange to indicate Viewer files failed to 
upload.

9 Reset This semi-recessed pushbutton can be pressed to reset the 
VK2100’s network settings.

10 Power LED Lights green when the unit is turned on. 

No. Component Description
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VK2100 Rear View

No. Component Description

1 Grounding Terminal The grounding wire attaches here.

2 Power Socket This is a standard 3-pin AC power socket. The power 
cord from an AC source plugs in here.

3 Power Switch This is a standard rocker switch that powers the unit 
on and off.

4 DC Output Ports Four outputs provide a total power output of 24W /2A 
max.

5 Relay Channels Four channels; normally open, isolated relays with a 
contact rating of 24VDC, 2A max.

6 IR / Serial Ports Four IR ports that can also be configured as RS-232 
TX ports. pin1: Signal / pin2: Ground. 

7 I/O Channels Four channels that can be configured as digital input 
or digital output ports. 

Digital Input: 0-24VDC programmable input range or 
contact closure with +12VDC pull-up

Digital Output: 250mA sink from 12VDC

Pin1~4: Signal / Pin5: Ground

8 RS-232 Serial Ports Two RS-232 ports with TX/RX functions supported.

9 RS-232/422/485 
Serial Ports

Four ports with supported RS-232/422/485 conversion 
by pin assignment and RTS/CTS flow control. The 
RS232, RS422, or RS485 connection is defined by 
pin. For pin assignments, see page 32.

10 Ethernet Port This RJ-45 port is used for the network connection. If 
no IP address is assigned within 30 seconds, the 
default IP settings will be used:

IP: 192.168.0.60 / mask: 255.255.255.0

11 Controller ID Switch This 16-segment switch is used for controller ID 
selection.

1 2 3 4 5 6 87 119 10
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VK1100 Front View

No. Component Description

1 Relay LED The LED lights green to indicate an active device 
connection (closed loop).

2 IR/Serial LED The LED lights green to indicate an active device 
connection and IR/Serial signals are being transmitted.

3 Serial LED The LED (1~2) lights green to indicate serial signals 
are being transmitted.

4 Ethernet Link / ACT 
LED

The LEDs provide information about the network 
connection:

Link: The LED blinks green to indicate Ethernet sig-
nals are being transmitted.

ACT: The LED lights green to indicate 100Mbps 
transmissions.

5 DC Output Overload 
LED

The LED lights orange to indicate DC output exceeds 
maximum output.

Note: When the LED lights orange, please unplug any 
of the connected devices to keep its total output under 
12W.

6 IR Receiver / LED This IR receiver passes the functions of a remote 
control to the VK1100 in learning mode. The distance 
between the IR remote and the receiver window 
should be kept under 10cm with a direct line of sight.

The LED blinks green to indicate the unit is ready to 
receive signals from an IR remote control.

1 2 3 5 6 7 84 9 10
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VK1100 Rear View

7 USB Port / LED This is where a USB device plugs in to upload Viewer 
files to the VK1100.

The LED blinks green to indicate Viewer files are 
being uploaded, and lights green to indicate a 
successful upload of Viewer files.

The LED lights orange to indicate Viewer files failed 
to upload.

8 Controller ID Switch This 16-segment switch is used for controller ID 
selection.

9 Reset This semi-recessed pushbutton can be pressed to 
reset the VK1100’s network settings.

10 Power LED Lights green when the unit is turned on. 

No. Component Description

1 Power Socket This is a standard 3-pin AC power socket. The power 
cord from an AC source plugs in here.

2 Power Switch This is a standard rocker switch that powers the unit 
on and off.

3 Relay Channels Four channels; normally open, isolated relays with a 
contact rating of 24VDC, 2A max.

4 DC Output Ports One output provides a total power output of 12W max.

5 IR / Serial Ports Two IR ports that can also be configured as RS-232 
TX ports. pin1: Signal / pin2: Ground. 

No. Component Description

1 2 3 4 5 76

8
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Rack Mounting the ATEN Control Box

VK2100

The VK2100 can be mounted in a 19” (1U) system rack. To install the device 
in a rack, do the following: 

1. Use the M3 x 8 Phillips head hex screws supplied with the Rack Mount 
Kit to screw the rack mounting brackets onto the front of the unit.

2. Position the unit in the front of the rack and align the holes in the mounting 
brackets with the holes in the rack.

6 RS-232/422/485 
Serial Ports

Two ports with supported RS-232/422/485 conversion 
by pin assignment and RTS/CTS flow control. The 
RS232, RS422, or RS485 connection is defined by 
pin. For pin assignments, see page 32.

7 Ethernet Port This RJ-45 port is used for the network connection. If 
no IP address is assigned within 30 seconds, the 
default IP settings will be used:

IP: 192.168.0.60 / mask: 255.255.255.0

8 Grounding Terminal The grounding wire attaches here.

No. Component Description
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3. Screw the mounting brackets to the rack.

VK1100

Optionally purchase an ATEN Rack Mount Kit to install VK1100 in a 19” (1U) 
system rack. To install the device in a rack, do the following: 

1. Remove the side and bottom screws from the front of the VK1000.
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2. Use the two bottom screws removed in step 1 to secure the bottom of the 
brackets, and two M3X6 hexagon screws (from the rack mount kit) to 
secure the side of the bracket to the VK1100.

3. Screw the mounting brackets to the rack.

M3X6 

Hexagon 

Screw
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Control Box Connections
Installation of the Control Box is a matter of connecting the appropriate wires. 
Refer to the installation diagrams on the pages that follow to setup each device 
and use the instructions below as a guide (each step provides a corresponding 
page with diagram for the VK2100 and VK1100), and do the following:

Connect the hardware devices to the Control Box using these instructions:

1. Use a grounding wire to ground the unit by connecting one end of the wire 
to the grounding terminal, and the other end of the wire to a suitable 
grounded object.

Note: Do not omit this step. Proper grounding helps prevent damage to the 
unit from surges or static electricity.

2. Use a Cat 5e/6 cable to connect the Control Box’s Ethernet port to the 
network.

3. Set the Controller ID to the appropriate setting for this unit.
4. Use the DC Output terminals to wire 12VDC power connections using the 

instructions on page 24.
5. Use the Relay terminals to wire relay device connections using the 

instructions on page 26.
6. Use the IR/Serial (TX) terminals to wire IR or serial device connections 

using the instructions on page 27.
7. Use the Digital I/O terminals to wire digital Input/Output device 

connections using the instructions on page 29.
8. Use the RS-232 terminals to wire RS-232 serial device connections using 

the instructions on page 31.
9. Use the DB-9 ports to wire RS-232/422/485 serial device connections 

using the instructions on page 32.
10. Connect IP-based devices to the same network as the Control Box. Refer 

to Ethernet, page 33 for details.

Note:
For KNX-compliant devices, connect the devices to a KNX IP 
interface, and then connect the KNX IP interface to the network where 
the Control Box is installed.
To check if the KNX functions are supported by the Control Box, see 
Datapoint Types, page 191.

11. Plug the power cord supplied with the package into the Control Box’s 3-
prong AC socket and then into an AC power source. 
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VK2100 Installation Diagram
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VK1100 Installation Diagram
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12VDC Power Output
One or four (VK1100 / VK2100) ports provide 12VDC of power with a total 
of 12 or 24 watts. The output can power one or four (VK1100 / VK2100) 
independent hardware devices, one or four (VK1100 / VK2100) loops for 
connected relay devices, or one or four (VK1100 / VK2100) digital output 
devices. If the combined current of the ports exceeds 1A (VK1100) or 2A 
(VK2100), the DC Power Overload LED lights orange, an alarm beeps three 
times and the ports are turned off. To return power to the ports, power off the 
Control Box, unplug all hardware connected to the 12VDC Power Output 
ports, power on the Control Box, and then plug in the hardware devices, one at 
a time, ensuring the current does not exceed 1A or 2A. 

The diagrams on the next three pages show ports on the VK2100. The VK1100 
is the same except that it has fewer 12VDC terminal blocks and no I/O ports. 

Independent Power Supply

 

Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

Provides 12VDC power to 

independent hardware devices.

Connects to

4 x 12VDC Output Ports
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Relay Power Supply

Connects to

Provides 12VDC power 

for the relay loop.

 

Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

4 x 12VDC Output Ports

Switch, Screen, Projector Lift, 

Lighting, Motorized Equipment, 

Motion Device, etc.
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Digital Output Power Supply (VK2100 only)

Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

Connects to
Switch, Screen, Projector Lift, 

Lighting and Equipment Control.

4 x 12VDC Output Ports

Provides 12VDC power

for the digital output loop.
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Digital Output Dual Power Supply (VK2100 only)

Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

4 x 12VDC Output Ports

Provides 12VDC power 

for the digital output loop.

Provides connection to 

digital output #2.

Provides connection to 

digital output #1.
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Relay
These four Relay channels provide connections to control hardware devices 
such as electric screens, projector lifts and other motorized equipment. Each 
relay is normally open by default. 

Normally
Open Closed

 

Normally Open, Isolated Relays

Contact Rating: 24VDC 2A Max

Switch, Screen, Projector Lift, 

Lighting, Motorized Equipment, 

Motion Device, etc.

Connects to

4 x Relay Channels
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IR / Serial
These two or four (VK1100 / VK2100) ports can be configured to connect IR 
and RS-232 devices. By default the ports are set to transmit IR signals. Use the 
ATEN Configurator software to configure the ports for RS-232 signals. The 
diagram below shows ports on the VK2100. The VK1100 is the same except 
that it has fewer terminals blocks and the Uni-directional setting is (0 to 5 V).

IR Connection: Connect a transmitter cable to the IR and Ground ports on the 
Control Box and install the IR transmitter on or near the device's IR receiving 
port, as shown on page 28.

Serial Connection: Connect the device's receiver (RX) and ground ports to the 
Serial (TX) and Ground ports on the Control Box. Next configure the same 
serial port setting on the Control Box and serial device so that they can 
communicate. 

Uni-directional (+ -5 V) 

Baud Rate: 300 to 115200 

(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 

Odd

IR: Blu-ray / DVD Player, TV, 

Audio Receiver, Projector, etc.

RS-232: Camera, Projector, 

Switch, Audio Mixer, Multimedia 

Device, etc.

Connects to

4 x RS-232 Ports

TTL Level (0 to 5 V)

Carrier Frequency: 

10kHz~455kHz

4 x IR Ports

or

VK2100
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One IR Transmitter

Two IR Transmitters

IR Receiver

Unidirectional IR

2 x IR Transmitters

IR Receiver
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Digital I/O
The four channels on the VK2100 can be used to connect Digital Input or 
Digital Output hardware devices such as switches, sensors, LEDs and relays. 
Each channel can be configured as either an Input (VDC), Input (Dry Contact) 
or Output channel.

Digital Input (Dry Contact): 
Digital inputs are hardware devices (switches, sensors, monitors) with two 
circuit signals – open and closed. These two signals provide indicators from 
sensors or switches of an event. An event can be the on/off power, dry contact, 
sensor or switch status from a device. This information is used to trigger events 
and functions through the VK2100. 

Digital Input (VDC):
Digital input 12VDC hardware devices (temperature, current and monitor 
sensors) provide voltage signals between 1 and 24. A digital input port detects 
if a voltage is above/below a specific threshold (1 to 24). If the voltage 
coming from a hardware device is higher than the set value, the VK2100 will 
detect the digital input as high. If the voltage coming from a hardware device 

Connects to

4 x Programmable Digital
Input Channels

Digital Input 
VDC Mode: 

-Input Voltage Range: 0 to 24 VDC

-Programmable Range: 1 to 24 VDC

Dry Contact Mode:

 -Pull-up 2k ohms to + 12 VDC

Digital Input: Switches, Sensors 

Monitors and Button Triggers.
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is lower than the set value, the VK2100 will detect the digital input as low. 
This information is used to trigger events and functions through the VK2100. 

Digital Output: 
Digital output channels provide non-powered dry contact (open and closed) 
circuit control of hardware devices such as electric screens, projector lifts and 
other motorized equipment. Devices connected to the Digital Output port must 
be connected through a Relay Module, as shown below. 

Digital Output: Switch, Screen, 

Projector Lift, Lighting and 

Equipment Control.

Connects to

4 x Programmable Digital
Output Channels

Digital Output:
 250 mA sink from 12 VDC

Relay 
Module
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RS-232
The two bi-directional RS-232 ports on the VK2100 provide serial control of 
hardware devices (projectors, matrix switches, etc.) and receive status 
messages from the connected devices. For bi-directional RS-232 control, the 
transmit, receive and ground pins must be wired on both the VK2100 and 
hardware device. Each hardware device requires different wiring. Please 
consult each hardware device's manual for details.

Projector, Matrix Switch, 

Camera, etc.

Baud Rate: 300 to 115200 

(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), even or 

odd

Connects to

2 x Bi-directional RS-232 Ports
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RS-232 / 422 / 485
These two or four (VK1100 / VK2100) bi-directional ports provide serial 
control of hardware devices (projectors, switches, etc.) with programmable pin 
assignments and receive status messages from the connected devices. The 
diagram below shows ports on the VK2100. The VK1100 is the same except 
that it has fewer ports.

Pin Assignments

RS-232 RS-422 RS-485

Pin2: RX Pin1: RX- Pin3: D+

Pin3: TX Pin2: RX+ Pin4: D-

Pin5: GND Pin3: TX+

Pin7: RTS Pin4: TX-

Pin8: CTS Pin5: GND

Projector, Matrix Switch, 

Camera, etc.

Connects to

Configurable by pin assignment

Baud Rate: 300 to 115200 

(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 

Odd

Flow Control: None (default) or 

RTS/CTS

4 x Programmable 
Bi-directional RS-232/422/485 
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Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 53) and 
the ability to add up to 25 LAN devices (page 83) per Control Box or up to 8 
LAN devices per Control Pad, as shown below. 

Ethernet

VK224 

VK236

VK248 

Expansion Box

SELEC T

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

ONVIF 

TCP 

PJLink 

Telnet

Telnet

1 x Ethernet Port

The RJ-45 port is used to connect 

the Controller to the network and 

access TCP, UDP, PJLink, ONVIF, 

HTTP, HTTPS, and Telnet devices. 

If the network switch does not 

support DHCP, the installed device 

will adopt the default IP 

address,192.168.0.60

eco PDU

Modular Matrix Switch

Ethernet Switch

UDP

Lighting HVAC Systems

KNX IP Interface

HTTP

HTTPS

Video Conferencing System
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ATEN Control Pad

Panel Components

VK0100

VK0200

2 3

4

9 8

7
5

1

6

Front View Rear View

Side View

9

8

1

2
3

5

4 6 7

Front View

Rear View

Side View
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No. Component Description

1 Buttons and Button 
LEDs

Indicate the status of the Control Pad and the 
assigned function, e.g. lighting or projector.

When a button LED:

lights orange, the Control Pad is powered on 
and the button is off.

lights white, the Control Pad is powered on and 
the button is on.

When all button LEDs:

blink orange and white once, the Control Pad is 
restoring its default settings.

blink orange and white repeatedly, the Control 
Pad is being upgraded for its firmware.

2 System LEDs Contains a LAN and a Link LED to indicate network 
connection and data transmission status:

LAN LED lights green to indicate that the Control 
Pad is connected to network.

Link LED lights green to indicate that the Control 
Pad is actively transmitting and receiving data.

3 Reset Switch Clear all configuration stored in the Control Pad and 
resets the Control Pad’s network settings to the following 
default settings:

IP address: 192.168.0.60

Subnet mask: 255.255.255.0

4 RS-232 Serial Ports Connect up to two RS-232 serial devices.

5 Relay Channels Connect up to two relay devices. Relay contacts are 
normally open, isolated with a contact rating of 24 VDC, 
1A max.

6 Digital Input Port Connect to one digital input device that supports 
programmable input (1 to 5 VDC) or dry contact (pull-up 
2k ohms to 5VDC).

7 Ethernet Port Connects to an Ethernet cable to provide power and 
access to the network.

8 Control Pad ID Switch Defines the Control Pad’s ID.

9 DC Power Port Connects to a 5V DC power adapter.
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Installing the Control Pads

Installation Steps

Follow the steps below to safely install the Control Pad.

VK0100

VK0200

Screen

Projector Video Switch

Projector
Projector

Lift

Ethernet
Cable

Camera

Network

Lighting
Control

Conference
System

Door
Sensor

Dry Contact
Device

PoE Switch

Relay

RS-232

DI

2

2
2

3

Relay

DI

Screen

Projector
Lift

Lighting
Control

Door
Sensor

Dry Contact
Device

2

Projector

Ethernet
Cable

Camera

Network
Conference
System

PoE Switch

RS-232
Projector Video Switch 2

2

2 3
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1. Prepare the installation site.

a) Choose a location where cables are free of interference.

b) Prepare a recession in the wall to accommodate the Control Pad. 
Download a CAD diagram from the product web page.

2. Connect the Control Pad to serial, relay, and/or digital input devices using 
the supplied terminal blocks. 
For details, see RS-232 Serial Connection, page 41, Relay Connections, 
page 42, Digital Input Device, page 43 respectively.

Note: To expand connection ports on the Control Pad, install ATEN 
Expansion Boxes.

3. To use PoE, connect the Control Pad to a PoE switch via an Ethernet cable.
For details, see Ethernet, page 44.

4. If you do not have power sourcing equipment for PoE, contact your local 
sales representative to purchase a power adapter and then follow the steps 
below to prepare the power cord.

a) Cut the connector end of the power adapter.

b) Strip 5 mm (0.5 cm) off the insulation cover of the power adapter cable 
to expose the +5V wire and the grounding wire.

c) Insert the expose +5V wire and the grounding wire tightly into the 
provided 2-pin terminal block connector.

Note: Use a voltmeter to determine the polarity of an exposed wire.

d) Plug the power terminal block to the DC power port on the Control Pad.

5. Use the ID Switch to assign an ID to the Control Pad.

6. Power on all the devices. The button LEDs light orange.

+5V

+5V

GND

GND

5mm (+)

(-)

4a

4b

4c
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7. Assemble the button caps onto the Control Pad. 

a) Assemble button caps of the same row with each other. 

b) From the top row, attach each row of button caps to the Control Pad by 
pressing on the hinges. 

Caution: When removing button caps, place your fingers on the top of 
button caps and then press downwards, as illustrated below. Pressing 
upwards from the bottom may cause damages to the button caps.



Chapter 2. Hardware Setup

39

8. Mount the Control Pad to the wall.

a) Secure the Control Pad to the wall with self-prepared screws.

b) Install the supplied faceplate to the Control Pad.
VK0100

VK0200 (EU)
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VK0200 (MK)
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RS-232 Serial Connection
The two bi-directional RS-232 ports on the Control Pad provide serial control 
of hardware devices (projectors, matrix switches, etc.) and receive status 
messages from the connected devices. For bi-directional RS-232 control, the 
transmit, receive, and ground pins must be wired on both the Control Pad and 
hardware device. Each hardware device requires different wiring. Please 
consult each hardware device's manual for details.

Projector, Matrix Switch, 

Camera, etc.

Baud Rate: 300 to 115200 

(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), even or 

odd

Connects to

2 x Bi-directional RS-232 Ports
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Relay Connections
These four Relay channels provide connections to control hardware devices 
such as electric screens, projector lifts and other motorized equipment. Each 
relay is normally open by default. 

Normally
Open Closed

 

Normally Open, Isolated Relays

Contact Rating: 24VDC 1A Max

Switch, Screen, Projector Lift, 

Lighting, Motorized Equipment, 

Motion Device, etc.

Connects to

2 x Relay Channels
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Digital Input Device
The digital input port on the Control Pad can be used to install a digital input 
device such as a switch or a sensor. The digital input channel can be configured 
to the VDC mode or the Dry Contact mode.

Digital Input (Dry Contact): 
Digital inputs are hardware devices (switches, sensors, monitors) with two 
circuit signals – open and closed. These two signals provide indicators from 
sensors or switches of an event. An event can be the on/off power, dry contact, 
sensor or switch status from a device. This information is used to trigger events 
and functions through the Control Pad. 

Digital Input (VDC):
Digital input 5VDC hardware devices (temperature, current and monitor 
sensors) provide voltage signals between 1 and 5. A digital input port detects 
if a voltage is above/below a specific threshold (1 to 5). If the voltage coming 
from a hardware device is higher than the set value, the Control Pad will 
detect the digital input as high. If the voltage coming from a hardware device 
is lower than the set value, the Control Pad will detect the digital input as low. 
This information is used to trigger events and functions through the Control 
Pad. 

Connects to

1 x Programmable Digital
Input Channel

Digital Input 
VDC Mode: 

-Input Voltage Range: 0 to 5 VDC

-Programmable Range: 1 to 5 VDC

Dry Contact Mode:

 -Pull-up 2k ohms to + 5 VDC

Digital Input: Switches, 

Sensors, Monitors, or Button 
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Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 53) and 
the ability to add up to 8 LAN devices (page 83) per Control Pad, as shown 
below. 

Ethernet

VK224 

VK236

VK248 

Expansion Box

SELEC T

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

ONVIF 

TCP 

PJLink 

Telnet

Telnet

1 x Ethernet Port

The RJ-45 port is used to connect 

the Controller to the network and 

access TCP, UDP, PJLink, ONVIF, 

HTTP, HTTPS, and Telnet devices. 

If the network switch does not 

support DHCP, the installed device 

will adopt the default IP 

address,192.168.0.60

eco PDU

Modular Matrix Switch

Ethernet Switch

UDP

Lighting HVAC Systems

KNX IP Interface

HTTP

HTTPS

Video Conferencing System



Chapter 2. Hardware Setup

45

Accessories

ATEN Expansion Box
ATEN Expansion Boxes (sold separately) provide additional ports for a 
flexible expansion of the ATEN Control System. This allows you to add and 
control additional devices in an environment where more devices are required. 
With the advantage of an Ethernet-based connection, the expansion boxes are 
easily connected to the ATEN controller via a LAN connection from a variety 
of locations across a network. The diagram below provides an example of the 
VK224 4-Port Serial Expansion Box setup. 

Note:
To add and configure ATEN Expansion Boxes, see The Device 
Configuration List, page 83 and Expander, page 84.

The available Expansion Box models include: 

Model Description

VK224 4-Port Serial Expansion

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box

Control Box

Serial Devices

Network

SELECT

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

Ethernet

Serial

VK224 (Rear)

Power Distribution 
Unit 

Video Matrix Projector Camera
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ATEN Keypad
The ATEN Keypad mounts to a wall to provide control of hardware through a 
Control Box. The setup of the Keypad to the Control System can be illustrated 
as follows:

Note: 
The following Keypad models are available:

You can have your Keypad buttons customized with text engraving. To 
make the order, go the this link: 
https://www.aten.com/ext_data/global_en/VK_Keypad_Engraving_Service/
aten_keypad.html

Model Description

VK108US 8-Button Keypad (US, 1 Gang)

VK112EU 12-Button Keypad (EU, 2 Gang)

Screen BD-Player

ProjectorLight Video Switch

Ethernet Switch

Powered by PoE
or DC 5V

VK1100
(Rear)

ATEN Keypad

https://www.aten.com/ext_data/global_en/VK_Keypad_Engraving_Service/aten_keypad.html
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Installation

To install the Keypad, follow the steps below:

1. Make sure you have created and uploaded a control interface (Viewer) for 
the Keypad and uploaded the Viewer to the Control Box. For details, see 
Design, page 94.

2. Prepare the installation site.

a) Choose a location where cables are free of interference.

b) Prepare a recession in the wall based on the following dimensions.
VK108US

50 cm (wall depth)

wall

54 cm (wall opening)
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Installing with a wall box Installing without a wall box
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VK112EU

3. Adjust the keypad ID switch (blue) to assign an ID number for the 
Keypad.

4. Adjust the Control Box ID switch (black) to specify the ID number of the 
Control Box which the Keypad will work with. One ATEN Control Box 
can work with up to 8 Keypads.

5. Connect the Keypad to LAN using an Ethernet cable to provide network 
connectivity and power.

Note: PoE is only supported if a power sourcing equipment is installed.

6. If you do not have a power sourcing equipment to supply power through 
the Ethernet cable, follow the steps below to prepare the power adapter 
and then plug it to the Keypad.

Note: Optionally purchase an ATEN power adapter for this application.

60 cm (wall depth)

wall

111 cm (wall opening)

63 cm (screw pitch)

120.2 cm (screw pitch)

6
0
 c

m
 (

w
a
ll 

o
p
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n
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g
)

5
2

.5
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m
 (

s
c
re

w
 p

it
c
h

)

+5V

+5V

GND

GND

5mm

5a

5b
5c

(+)

(-)
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a) Cut the connector end of the power adapter cable.

b) Strip 0.5 cm off the insulation cover of the power adapter cable to 
expose the two wires, the +5V wire, and the grounding wire.

c) Insert the exposed wires into the supplied 2-pin terminal block.

Note: To determine the wire polarity, use a voltmeter.

7. The LAN and Link LEDs light green to indicate that the Keypad 
successfully links to the assigned Control Box.

Note:
Make sure that the Keypad is in the same subnet with its assigned 
Control Box. 
The Keypad adopts the default IP address 192.168.0.60 if the network 
switch does not support DHCP. To configure the IP address, log in the 
web interface using the default IP address and the default password 
(password).

8. Secure the Keypad to the wall.

9. Follow the layout created in the profile and assemble the button caps onto 
the Keypad. 

a) Assemble button caps of the same row with each other. 

b) From the top row, attach each row of button caps to the Keypad by 
pressing on the hinges. 
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Caution: When removing button caps, place your fingers on the top of 
button caps and then press downwards, as illustrated below. Pressing 
upwards from the bottom may cause damages to the button caps.

10. Attach the faceplate to the Keypad.
VK108US

VK112EU
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Component
The VK108US and VK112EU Keypads share the same hardware layout. For 
demonstration purpose, VK112EU is used as an example below.

No. Component Description

1 Buttons VK108US
The Keypad can be customized up to 14 different 
layouts using 4 to 8 buttons.

VK112EU
The Keypad can be customized up to 125 different 
layouts using 6 to 12 buttons.

2 Button LEDs A button LED:

Lights orange to indicate the power is on.

Lights white to indicate the Keypad is in operation.

Blinks orange and white to indicate that firmware 
upgrade is in progress.

3 System LED Indicators LAN: lights green to indicate that the Keypad is 
connected to LAN.

Link: lights green to indicate that the Keypad is 
connected to the assigned Control Box.

4 Reset Pushbutton Press to reset the Keypad to its default network 
settings.

5 DC Power Plug a power adapter into this DC power input.

6 Keypad ID Switch (blue) Sets the ID of the keypad (1~8).

7 Control Box ID Switch 
(black)

Sets the ID of the Control Box (1 ~ 16).

2

37

5

6

4

1 8

68.51 mm

49.5 mm

28 mm
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Layout Examples
VK108US

VK112EU

8 LAN Port Connects the Keypad to LAN

Supplies power (PoE) if a power sourcing 
equipment is installed.

No. Component Description
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Chapter 3
Browser Operation

Overview

The Control Box can be configured over a standard TCP/IP connection via its 
built-in Graphical User Interface (GUI). Because it can be accessed from 
anywhere over a network or the Internet, operators can easily log in via a web 
browser. The web interface can be used to upload licenses, set the access key, 
enable monitors and update the firmware. 

Logging In

To access the GUI, type the IP address of the Control Box into the address bar 
of any browser. If a Security Alert dialog box appears, accept the certificate – 
it can be trusted. The Welcome screen appears:

The default IP address is http://192.168.0.60 
The default access key is: password
Only one user can log in at a time
Supports Internet Explorer browsers IE9 and higher
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Dashboard

The Dashboard appears when you successfully log in to the Control Box. The 
Dashboard gives a quick view of each setting and provides a link to each page. 
Click Manage to configure the settings. 

The top bar provides two options:

 Click to enter the Settings page. 

Click to Logout of the web session. 
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Settings

The Settings page contains tabs to provide options to configure the Control 
Box. The page is divided into two parts, the Interactive Display Panel which 
is used to configure the options and the Top Bar which provides icons to exit 
the settings page and log out of the web session. 

The Settings page opens on the General tab, as shown below:

The General tab provides settings and information about the Control Box, as 
described in the table below. 

Controller Info Provides network and identification information pertaining to the 
Control Box.

Device Name: Sets the device name.
Controller ID: Displays the Control Box ID # set on the rear of 
the unit.
IP Address: Provides the IP address of the Control Box. 
MAC Address: Provides the hardware MAC address of the Con-
trol Box. 

Date & Time Provides two options to set the date and time: 
Time Zone: To establish the time zone for the Control Box, use 
the drop-down menu and choose the city that most closely corre-
sponds to where it is located. 
Set Manually: Use the drop-down menus to manually set the 
Date (Year/Month/Day) and Time (Hour:Minute:Second). 
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Firmware Displays the Current Firmware version and option to upgrade. 
Click Update Firmware to open the Firmware Upgrade window. 
Click Browse to select the firmware upgrade file.
When Check FW Version is selected, the system will check the 
current firmware version against the one being used to upgrade the 
Control Box. If the device version is higher than the upgrade 
version a dialog box informs you and gives you the option to 
continue or cancel.
After the file has been selected, click Update to start the firmware 
upgrade. 
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Licenses for Mobile Control
A license is a software permit that an ATEN controller grants to a mobile 
device when the mobile device connects to the ATEN controller for remote 
control. If you have three licenses for a VK2100 device, you can operate up to 
three mobile devices at the same time. Refer to the table below for the number 
of free licenses with which each model of controllers is equipped and the 
maximum number of licenses each controller supports. To purchase additional 
copies of license, contact your local sales representative.

You can use the Licenses tab to:
Find out the total number of licenses, the number of licenses that are 
available, and those that are in use
Upload licenses to the ATEN controller
View license information

Licenses ATEN Control Box
(VK1100 / VK2100)

ATEN Control Pad
(VK0100 / VK0200)

No. of free licenses 2 0

Maximum no. of licenses 10 10

Licenses In Use: displays the number of licenses being used by mobile 
devices. 

Not in Use: displays the number of licenses available for use. 

Total shows the number of licenses purchased for use on the 
Control Box. 

Update License Clicking Add opens the Add License window to upload new licenses to 
the Control Box. Click Browse to locate the license file and Add to 
upload the license(s).

Remove When a device is accessing the Control Box you can click the Remove 
button to disconnect the session. 
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Storage
The Storage tab displays information about the space available for storing 
viewer profiles on the Control Box.

Storage This section shows a graph displaying the percentage of space 
available on the Control Box to upload viewer profiles, as well as:

Space Used: The amount of space currently being used to store 
viewer profiles uploaded to the Control Box. 
Space Available: The amount of space currently available to 
store viewer profiles on the Control Box. 
Total Space: The total amount of space available to store viewer 
profiles on the Control Box. 

Existing Viewer This section lists all the viewer profiles that are currently stored on 
the Control Box with their name and assigned room. Click Remove 
to delete a single viewer profile or Remove All to delete all viewer 
profiles from the Control Box. 
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Access
This tab allows you to configure the access key (password) of the ATEN 
controller’s web interface and to set a validity period of accessing the ATEN 
Control System using an activation key.

Access Key The access key is the password that is required to do the following:

Log in the ATEN controller’s web interface.

Upload projects and Viewers from Configurator to ATEN 
controller (page 156).

Download Viewers from ATEN controller to mobile devices 
using ATEN Control System App (page 185).

The following settings are available:

Current Access Key, New Access Key, Confirm Access 
Key: Use these three fields to set or change the access key. 
The default access key is password.

Show on dashboard: Select this option to show the access 
key setting on the Dashboard tab.

Enable Viewer Access Key: Select this option to request for 
the access key when uploading projects or Viewer profiles to 
the ATEN controller or downloading Viewers to mobile devices. 
Once enable, you can also configure this setting from the 
Dashboard tab.
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Activation Key The activation key is a string of letters and numbers used to assign 
a validity period of accessing the ATEN Control System.

To set up a validity period for accessing the ATEN Control System:
1. Select Your access to ATEN Control System will expire in 

and type the number of days.

2. Type an activation key. Follow the guidelines below when 
creating your activation key:

Max number of characters: 32

Allowed characters: uppercase and lowercase letters, 
numbers, and underscore

Max. number of days: 999 days

3. Type the activation key again to confirm.

4. Click Save. The limit is immediately applied. For example: 

Note: Keep the activation key somewhere secure because it 
cannot be recovered. In case you forget the activation key, 
press the reset button/switch for 8 seconds to set the ATEN 
controller to default. This will reset all configuration of the 
controller to default and remove any projects and Viewers 
stored on the ATEN controller.

To disable the validity period, click Enter Activation Key to type the 
activation key provided by the system integrator.
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Monitor
The Monitor tab allows you to view and enable the monitors that have been 
configured for Flags and digital input devices in the VK6000 software. Check 
the Show on dashboard box to show the Monitor settings on the Dashboard. 
Click the slide bar next to the monitor you want to enable or use the drop-down 
menu to select All On or All Off.

For more information about creating monitors, see Library, page 133. 
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Network
The Network tab allows you to view and configure the Control Box’s network 
settings. Select Manually to set a static IP Address, Subnet Mask, and Default 
Gateway, or Use DHCP to have the server assign an IP address to the Control 
Box. 

Note: Make sure to set the ATEN controller’s IP address and Default Gateway 
to the same subnet. 
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Connections
The Connections tab allows you to view the connection statuses and IP 
addresses of licensed devices, ATEN Keypads, and ATEN Expansion Boxes. 
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Schedule
The Schedule tab lists scheduled events predefined using the ATEN 
Configurator. You can use this tab to do the following:

Enable or disable scheduled events.
Enable or disable scheduled days

For details on setting up scheduled events, see Scheduled Events, page 150.
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Security
The Security tab allows you to secure the browsing sessions between your 
computer and the ATEN controller’s web interface using SSL encryption. 
Purchase and obtain an SSL certificate from a trusted certifying authority and 
click Upload in this page to apply the certificate.
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Chapter 4
ATEN Configurator (VK6000)

Overview

The ATEN Configurator (VK6000) is a GUI-based management tool that helps 
you set up and configure the connected hardware and create control interfaces 
to be used by mobile devices and ATEN Keypads. 

Installation

To install the ATEN Configurator software, do the following:

1. Download ATEN Configurator.

a) Visit the ATEN download page.
http://www.aten.com/global/en/support-and-downloads/downloads/

b) Search for “VK6000”. A list of downloads for VK6000 appear.

c) Click ATEN_configurator_software_x.x.xxx.zip to download.

2. Open the downloaded zip file and double-click 
ATEN_configurator_software_x.x.xxx.exe to run the setup. This screen 
appears.

http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
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3. Click Next. This screen appears.

4. If you agree with the License Agreement, select I accept the terms of the 
license agreement, and click Next. Click Print to print the Software End 
User License Agreement. This screen appears.
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5. To change the destination location, click Change. Click Next to proceed 
using the default location. This screen appears.

6. Click Install. When the process is complete, a confirmation message 
appears.

7. Click Finish.
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Getting Started Tasks

After you have installed and launched the ATEN Configurator, the Main Page 
(page 72) appears. You will be guided to create and configure a project using 
the 4 tabs in the Configurator’s interface, as illustrated below. 

Hint: You can click the tabs to switch among different pages for configuration. 

The steps below provides an overview of the getting started tasks.

1. In the Project tab, do the following.
Provide information on the ATEN controller that you have set up.
(Optional) Provide client information for the specified ATEN 
controller.
Click Add Controller if you have more than one controller in the 
environment.

For more details, see Project, page 79.

Click Start Project to proceed.

2. In the Device tab, do the following.
Connect each controller with its managed devices by adding them to 
the controller’s Device Configuration list, enter the connection 
settings, and specify the physical locations.
(Optional) Add another controller and/or Expansion Box to the project 
by clicking Add Controller or Expander.
Connect the Extension Box with its managed devices by adding them 
to the Extension Box’s Device Configuration list. 

For more details, see Device, page 81.

Click Design or the Viewer tab to proceed.
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3. In the Design tab, do the following.
Create and configure a control interface (Viewer). For more 
information, see Design, page 94.
(Optional) Set up scheduled events to automatically carry out specified 
actions.
(Optional) Add additional conditions and actions to buttons using 
Flags. For details, see Flag, page 134.
(Optional) Create a sequence of actions for a button by creating a 
Macro. For details, see Macro, page 148.
(Optional) Create a Synced Variable for a device setting that is 
controlled by two or more components in one control interface. For 
details, see Synced Variables, page 151.

4. In the Upload tab, upload this profile to the controller. For details, see 
Upload, page 156.
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Main Page

Double-click the Configurator.exe shortcut to open the ATEN Configurator 
software. The Project page appears:

1 Menu bar The Menu Bar contains categories with options that 
pertain to different sections of the software. Menu bar 
items are listed on page 73. 

2 Project Bar The Project Bar contains four tab and the Library 
icon. Each tab relates to a step required to setup the 
project profile. Each step and the Library can be 
selected by clicking on the bar. Each step is 
discussed, starting on page 79, and the Library on 
page 86.

3 Interactive Display Panel This is the main work area. The page that appears 
here reflects the project tab that is selected. 

4 Library The Library contains the devices, graphic, flag, 
macro, and monitor databases. Each section allows 
you to add custom items or choose from ready made 
selections.

5 Toggle Bar These three icons are used as a toggle to show or 
hide the right, left and bottom control panel. 

6 Simulator The Simulator button is used to test a viewer’s 
interface after it has been created in Design. The 
simulator allows you to tryout the interface as it would 
work on a mobile device but without actually 
controlling devices. Use the mouse to click through 
the page links. 

2

1

3

4 5

6
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Menu Bar

Use the Menu Bar to select options in each project tab. The table below 
provides a description of each menu item. 

Menu Sub-Menu Description

File New Project Select to create a new project. 

Open Project Select to browse and open a previously 
saved project. 

Restore Project from Controller Downloads a previously backed up 
project from a controller.

Close Closes the current project and returns to 
the Project tab. 

Save Select to save changes to the current 
project. 

Save as Use this option to save the project as a 
different name.

Export Viewer to USB
(Not supported by ATEN Control 
Pad)

Exports viewers and an access key to a 
USB drive. After exporting the data onto 
a USB drive, plug the USB drive into the 
Control Box’s USB port to upload the 
viewer files and the access key. These 
files can only be read by the Control Box 
and are not project files that can be 
opened by the ATEN Configurator 
software.

Project Report Click to save a PDF file that contains 
detailed information about each part of 
the current project.

Import ETS Project Import an ETS project file for your KNX 
devices. 

Recent Projects Select to view a list of recent projects that 
can be clicked on to open. 

Exit Select to close the project and exit.
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Edit Undo Select to undo a change when editing a 
viewer page in Create & Design Viewer.

Redo Select to redo a change when editing a 
viewer page in Create & Design Viewer.

Cut/Copy/Paste Select to cut, copy or paste text and 
objects when editing a viewer page in 
Create & Design Viewer. When used to 
copy and paste a button, both the 
General and Action properties are copied 
(see page 111). 

Paste Graphic Only Select to paste a button’s image but not 
its Action properties in Create & Design 
Viewer.

Delete Select to delete highlighted text and 
images when editing a page in Create & 
Design Viewer.

Delete Action Only Select to delete the Action properties of a 
button in Create & Design Viewer.

Select All / Deselect All Use either option to select or deselect all 
objects when editing a viewer page in 
Create & Design Viewer.

Preferences Display 
Language

Use to select the language for the 
interface.

SSH 
Destination

Click to choose the location of the 
executable for the SSH Client software. 
To execute the program, go to the menu 
bar and select Tools → SSH Client.

Interface Check a box to enable the feature 
described below:

Show Welcome Page: displays the 
Welcome screen when the ATEN Con-
figurator software opens. 
Auto Page Creation: automatically 
creates a viewer page in Create 
Viewer & Design, for every hardware 
device that is configured in Select 
Device & Configuration.
Show Password: displays the charac-
ters of the access key in the Edit 
Access Key dialog box.
Automatically check for updates: 
automatically checks for updates and 
notify the user when an update is 
available.

Menu Sub-Menu Description
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View These options are available from Create Viewer & Design → Edit Viewer.

Zoom Zooms the viewer page to 25%, 50%, 
75%, 100%, 200% or Fit in Window. 
Note: A mouse wheel can be used to 
zoom the viewer page in or out. 

Project Information Select to go to Project Information.

Device Configuration Select to go to Select Device & 
Configuration.

Viewer Design Select to go to Create Viewer & Design. 

Project Upload Select to go to Search & Upload. 

Properties Select to show/hide the Properties 
window when editing a viewer page.

Align to Grid Select to automatically align objects with 
the grid. This places objects in perfect 
alignment with the grid dots when they 
are moved. Use Show Grid to display the 
grid dots. When Align to Grid is not 
selected, objects can be placed 
anywhere on the page.

Show Grid Select to display the grid dots on the 
page. Use with the Align to Grid option to 
set objects in perfect alignment on the 
page. 

Object These options are available from Create Viewer & Design → Edit Viewer.

Button Adds a button to the viewer page. 

Text Adds a text box to the viewer page.

Image Adds an image to the viewer page. 

Scroll View Adds a scroll box to the viewer page, 
then double-click it to add buttons. Use 
the box as a scroll window to easily 
access a list of buttons on the page. 

Video Adds a video box which allows you to 
view video. The video box can be resized 
using the Properties sidebar or by 
dragging a small box on the boarder to 
resize it to the desired shape. 

Slider Bar Adds a slider bar to the viewer page. 
Slider bars are used to adjust the value 
of a device setting, such as the volume 
level of an audio device. 

Menu Sub-Menu Description
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Object PowerPoint Control Template Adds a PowerPoint Control template to 
the Viewer. This control template is used 
to control PowerPoint files saved in a 
target computer.

Media Control Template Adds a Media Control template to the 
Viewer. This control template is used to 
control media files saved in a target 
computer.

Group Group Select multiple objects and use Group to 
lock them together. Objects in the group 
will move together as one.

Radio 
Group

Select multiple buttons and use Radio 
Group to associate them as follows: 
selecting a button that belongs to the 
radio group deselects the previously 
selected radio button within the same 
group. 

Ungroup Select grouped objects and use 
Ungroup to unlock the group.

Order Bring to 
Front

Moves an object to the top position when 
objects are layered.

Send to 
Back

Moves an object to the bottom position 
when objects are layered. 

Bring 
Forward

Moves an object up one position when 
objects are layered. 

Send 
Backward

Moves an object down one position when 
objects are layered. 

Align Left Aligns two or more selected objects to 
the Left side of the object that is selected 
last. 

Center Aligns two or more selected objects to 
the horizontal position of the object that 
is selected last. 

Right Aligns two or more selected objects to 
the Right side of the object that is 
selected last. 

Top Aligns two or more selected objects to 
the Top side of the object that is selected 
last. 

Middle Aligns two or more selected objects to 
the vertical position of the object that is 
selected last. 

Bottom Aligns two or more selected objects to 
the Bottom side of the object that is 
selected last. 

Menu Sub-Menu Description
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Object Make Same Size Width Resizes two or more selected objects to 
the same width of the object that is 
selected last. 

Height Resizes two or more selected objects to 
the same height of the object that is 
selected last. 

Both Resizes two or more selected objects to 
the same width and height of the object 
that is selected last. 

Space Evenly Across 
Page Width

Spaces two or more selected objects 
evenly across the width of the page.

Across 
Page 
Height

Spaces two or more selected objects 
evenly across the height of the page.

Between 
Objects 
Horizontally

Adjusts the horizontal space between 
three or more selected objects to the 
average distance between each of the 
selected objects.

Between 
Objects 
Vertically 

Adjusts the vertical space between three 
or more selected objects to the average 
distance between each of the selected 
objects.

Tools Database Generator Opens the ATEN Database Generator 
which is used to manually add and 
configure hardware devices. This is 
where you can create custom devices to 
add to My Device Library. See ATEN 
Database Generator, page 151, for 
details.

Simulator The Simulator is used to test a viewer’s 
interface after it has been created in 
Design. The simulator allows you to 
tryout the interface as it would work on a 
mobile device but without actually 
controlling devices. Use the mouse to 
click through the page links.

SSH Client This runs the SSH Client software 
selected under Edit → Preferences → 
SSH Destination. The SSH Client is used 
to communicate with the Control Box. 

Windows New Page Click to create a new viewer page or 
select a page to open in Create Viewer & 
Design.

Menu Sub-Menu Description
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Help About Provides the firmware version and 
support information for the Configurator 
software. 

Check for Updates Checks if ATEN Configurator is up-to-
date.

Menu Sub-Menu Description
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Project

The Project tab allows you to enter details about the installation to start the 
project. Enter the information using the table below as a guide.

Name Enter the project name you are setting up. You can create multiple 
projects but for most installations only one project is required. 

Add Controller Click to add Control Boxes to the project. The number added should 
equal the number of Control Box units being installed. A project can 
have up to 16 Control Boxes. A Controller is the software link to the 
Control Box being installed.

Controller ID Displays the Controller ID for the Control Box in the project. Use the 
Controller ID in the project to set the Controller ID Switch on the 
rear of the Control Box.The device configuration and viewer profile 
will be uploaded to the controller set with the same ID.

ATEN Controller 
Type

Select the Control Box model you are installing. 

Number of Rooms Enter the number of rooms each Control Box will control. Each 
hardware device you add will be associated with a room. When 
buttons are configured in the Design tab, you can select a Room 
under Button Action to filter the Device list so that only hardware in 
that room appears. This link between the Control Box, devices and 
room is how the viewer profile knows which devices to control.
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Name Enter the client name associated with the project.
Address Enter the client address associated with the project. 
Phone Enter the client phone number associated with the project. 
Remove 
Controller

Click to delete a Control Box from the project.

Start Project Click to begin configuring hardware devices. The Select Device & 
Configuration tab will open. 
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Device

The Device tab is used to configure Control Box ports according to the 
connected hardware device. 

Device Configuration This section lists the ports for each Control Box. Select a 
Controller, Expander or Room in the left sidebar to display the 
ports. Each port needs to be configured according to the 
hardware device connected to it (see page 81).

Left Sidebar This section lists the Controllers, Expanders and Rooms. Use the 
sidebar to add a Control Box, Expander or Room. When a port is 
configured with a device, the device appears listed below the 
room on the sidebar (see page 84).

Library Click this icon to open the Library on the Device Library tab 
which contains a database of hardware devices that are used to 
configure VK2100 ports (see page 86).

Properties The Properties section displays information about the selected 
controller, port or room (see page 84). 
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Adding Devices to ATEN Configurator
Add the devices managed by the controller to the Device Configuration list and 
configure their settings.

To add KNX devices, follow the steps below:

1. Click File and then Import ETS Project. The configurations for your 
KNX devices appear in the Controller tab on the left-side bar.

2. In the Controller tab, click on KNX IP Interface and type its IP address 
and port in the Properties column.

To add a device that is not KNX compliant, follow the steps below:

1. In the Device Configuration list, select a port by clicking an entry or 
click Add More Devices to create a new entry.

2. Click Library to find the device you want to add and double-click the 
entry to add the device. Proceed to the next step if the device is not in 
the Library.

3. Create a device using the built-in Database Generator.

a) Follow the steps in Edit / Add New Device, page 155 to create the 
device.

b) In the Library window, click Library and select My Device 
Library.

c) Double-click the device you just created to add it to the Device 
Configuration list.
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The Device Configuration List
The Device Configuration page lists the Control Box ports by type. Click a port 
to view its Properties (page 84). Double-click a port to open the ATEN 
Device Library and search for the hardware device to configure the port. 
Configure each port according to the hardware device connected to it.

Type Lists the VK2100 port type and number.
Device Lists the device name entered in Properties. 
Mode Lists the port’s communication mode. Click an arrow to select 

options:
Serial: RS232, RS422, or RS485
I/O: Input (VDC), Input (Dry Contact) or Output
IR: IR or RS232

Room Lists the room selected for a device. The rooms available depend 
on the number of rooms added to the controller. No drop-down 
menu appears if there is only one room. Each controller must 
have at least one room. Select the room where the device is 
installed. 

+ Add More Devices RS422, RS485, LAN and IR ports can cascade additional devices 
that are connected to the first unit. IR ports can cascade 1 device, 
RS422 and RS485 ports can cascade up to 2 devices and LAN 
ports can cascade up to 25 devices.
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Left Sidebar
Controller
The Left Sidebar provides a tree view of the 
controllers, expanders and rooms. Each controller 
represents a Control Box with the room(s) it manages. 
Selecting a controller allows you to configure its 
ports. When a port is configured for a device, it 
appears listed under the Room. 

Each controller must have one room. When installing 
multiple Control Boxes in one room, add a room with 
the same name to each controller. 

Each controller name ends with an ID number: 
VK2100-ID01. Use this number to set the Controller 
ID Switch on the rear of the Control Box. This links 
the controller in the software to the Control Box being 
installed.

Right-click a controller to Add Room or Delete 
Controller.

Room
Rooms are associated with a controller and the viewer 
profile so that the information is uploaded to the 
correct Control Box to control the hardware devices. 

Right click a room to Delete or Rename the room.

Use the buttons at the bottom of the sidebar to Add 
Room. 

Expander
ATEN Expansion Boxes connect over a network to 
add ports to the Control Box via its Ethernet port. 
Clicking Add Controller or Expander opens a 
window which allows you to select a device to add:
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Library

The Project Bar provides the Library option. 
Use the Device Library tab (shown right) to configure 
VK2100 ports according to the hardware device 
connected to it. The Device Library provides an 
extensive database of hardware devices that can be 
double-clicked or drag and dropped into the Device 
Configuration page to configure the VK2100 ports. The 
Device Library is discussed on the next page.
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Device Library
The Device Library tab is a database of hardware devices that instantly 
configure VK2100 ports. Search the library for the device connected 

to a VK2100 port then add it to configure the port. For devices not in the 
library, use the ATEN Database Generator to create custom hardware (see 
page 151). Click Library on the Project bar or double-click a port on the 
Device Configuration page to open the ATEN Device Library. 

Add a device by clicking Add to Project or by drag & drop. 

To search for a device type keywords into the box and click .
Click a tab to filter by All, Serial, DO, IR, Relay or Ethernet.
Click headings to sort by Brand, Device Type, Model or Version.
Use the drop-down menu to select:

ATEN Device Library – ATEN’s database of hardware devices. 
My Device Library – Devices added from the Database Generator.
Create Device – Opens the Database Generator to create custom 
hardware devices for My Device Library (page 151).
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Properties
The Properties sidebar displays information and settings for the selected 
device. The information available depends on the device or port selected.

Name: Displays the device name and 
allows you to edit it. 

Add Device: Adds devices. You can use 
either of the following methods to add 
devices:
- Type the device name in the Name field 
and click Add Device.

- Click the arrow button (following the 
Add Device button) and select add device 
from library to open the device library. 
Double-click a device to bring in its 
information and settings.

Category: Displays the category of the 
selected device.

Brand: Displays the brand of the 
selected device.

Model: Displays the model of the 
selected device.

Version: Shows the firmware version 
selected for the device. Use the drop-down 
menu to select a different firmware 
version. Click the menu box next to the 
version number to open a PDF with the 
version history. The version history and 
different versions for a device can be 
manually added/updated via the Database 
Generator (see step 3 of Edit / Add New 
Device, page 155).

Connecting Settings: Configure the 
parameters for the selected serial or 
Ethernet devices. For details, see Serial 
Device, page 88 and Ethernet Device, 
page 88 respectively.

Advanced Settings: Click Advanced and 
use the Delay Interval drop-down menu to 
set a timed delay for each command before 
it is sent to the device. 
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Connection Settings
Serial Device
Provides drop-down menus to configure the Baud Rate, Data Bit, Stop 
Bit, Parity and Flow Control settings. Configure these options to match 
the serial device settings. Click Advanced to configure to 

Click Advanced to configure the following parameters.

I/O Device
Two drop-down menus appear for Input (VDC) ports: Lower Threshold 
and Upper Threshold. Set the thresholds according to the hardware 
device you are connecting and then configure a Monitor (see page 136).

Ethernet Device
These options allow you to configure the settings for a PJLINK, 
TELNET, UDP, ONVIF, TCP, HTTP, HTTPS device. Select the 
Protocol Type and then enter the IP Address, Port, Username and/or 
Password as required by the option you select. Each Control Box can add 
25 LAN devices that connect through the Ethernet port. Use the Protocol 
Type drop-down menu to select:

Delay Interval Use the Delay Interval drop-down menu to set a time delay 
for each command before they are sent to the device. 

Feedback Timeout Sets the duration for receiving a feedback from the serial 
device before the controller times the session out.
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PJLINK – allows control of data projectors over a network using the 
PJLink protocol. Enter the IP Address, Port and Password of the LAN 
projector or device used to control the projector. 

TELNET – allows control of a LAN device via telnet commands. 
Enter the IP Address, Port, Username and Password of the telnet 
controlled LAN device. Use the Advanced Telnet options to configure 
the following parameters: 

Delay Interval Use the Delay Interval drop-down menu to set a 
time delay for each command before they are 
sent to the device. 

Delay after login Sets a delay (to allow a connection to be 
established) before the First and Second 
Commands are sent to the device. 
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ONVIF – allows use of the ONVIF protocol which allows video from 
devices to be controlled and displayed through the ATEN Control 
System App. Enter the IP Address, Username and Password of the 
ONVIF device you are adding. Use the Advanced ONVIF options to 
configure Delay Interval:

TCP – allows control of a TCP LAN device. Enter the IP Address and 
Port of the device you are adding. Use the Advanced TCP options to 
configure the following parameters:

Send command after 
connection

Select the Format and enter a First and Second 
Command to send to the device after a 
successful connection has been established. 

Automatically reconnect if no 
return message is received 

Check this box if you want to continue 
reconnection attempts when no return message 
is received from the device.

Delay Interval Use the Delay Interval drop-down menu to set a time delay 
for each command before they are sent to the device. 
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UDP – allows control of UDP-compliant devices. Enter the IP Address 
and Port of the added device. Use the Advanced UDP options to 
configure Delay Interval:

Delay Interval Use the Delay Interval drop-down menu to set a 
time delay for each command before they are 
sent to the device. 

Delay after login Sets a delay (to allow a connection to be 
established) before the First and Second 
Commands are sent to the device. 

Send command after 
connection

Select the Format and enter a First and Second 
Command to send to the device after a 
successful connection has been established. 

Automatically reconnect if no 
return message is received 

Check this box if you want to continue 
reconnection attempts when no return message 
is received from the device.

Delay Interval Use the Delay Interval drop-down menu to set a time delay 
for each command before they are sent to the device. 
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HTTP(S) – allows control of HTTP or HTTPS devices. Enter the IP 
Address, Port, Username, and Password of the device you are 
adding. Specify the authentication type (Auth Type) using the drop-
down list. Use the Advanced options to configure the following 
parameters:

Controller
When you select a controller from the left side bar, the properties provides 
a drop-down menu to set the Controller ID (ID01~ID16). See Controller 
ID, page 79, for details. 

Auth Type Select the HTTP or HTTPS authentication type that the 
device uses.

Delay Interval Use the Delay Interval drop-down menu to set a time delay 
for each command before they are sent to the device. 
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Expander
When you select an expander (VK224, VK236, VK248) from the left side 
bar, the properties provides a drop-down menu to set the Expander ID 
(ID01~ID08) and the option to configure the IP Address. 

To add an expander, click Add Controller or Expander on the left 
sidebar, then use the arrow and select an ATEN Expansion Box to add. The 
expansion box and ports will be listed on the Device Configuration page, 
as shown below: 
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Design

The Design tab is for creating a Viewer – the user interface that controls the 
hardware from a mobile device or Keypad. Create a viewer and add the pages 
to control the hardware according to the setup you are installing. 

Viewer Settings The Viewer Settings page appears if no viewer has been created 
so that you can set the Viewer Properties. The viewer properties 
must be set before you begin configuring the viewer’s pages. When 
you are finished, click Done to begin designing the viewer pages. 
See Select Viewer, page 95, for details.

Left Sidebar The left sidebar lists each viewer and its pages.The sidebar allows 
you to add viewers and pages. These options become available 
after clicking Done on the Viewer Settings page. See Left Sidebar, 
page 84, for details.

Library Click this icon to open the Library which provides access to the 
Graphic (page 131), Flag (page 134), Monitor (page 136), Macro 
(page 148), Scheduled Event (page 150), and Synced Variables 
settings (page 151).

Simulator The Simulator button is used to test a viewer’s interface after it has 
been created. The simulator allows you to tryout the interface as it 
would work on a mobile device but without actually controlling 
devices. Use the mouse to click through the page links.

Select Viewer The Select Viewer section allows you to configure the basic 
settings and type of viewer you want to create. See Select Viewer, 
page 95, for details.
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Select Viewer
The Select Viewer page sets the basic properties for the viewer that you create. 
A viewer is the interface designed for a mobile device or ATEN Keypad with 
the pages and buttons used to control each hardware device. Use the table 
below to select the viewer settings, and then click Done to continue. 

Select Viewer Displays the basic settings that must be selected to create a viewer 
profile. 

Mobile Device: Select to create a viewer profile that will be 
uploaded for use on a mobile device.
Keypad: Select to create a viewer profile that will be used to 
configure buttons for a Keypad installation (see page 47).
Control Pad: Select to create a viewer that will be used to control 
a Control Pad on a mobile device.

Type Use this drop-down menu to select the mobile device that will be 
used to control hardware devices in a room. This sets the resolution 
for the viewer to fit on the mobile device’s screen. 
Choose a Custom selection to configure a screen size with the 
Resolution drop-down menu below it.
Note: If you select Custom Windows Device – the Windows OS has 
a limitation for adding buttons to the viewer pages on Windows 
mobile devices. See Properties, page 101, for details. 
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Left Sidebar

Viewer
The Left Sidebar provides a tree view of the Viewers 
and Pages. Clicking a viewer opens the Page Overview 
which is a layout of the viewer’s pages. 
Right click a viewer to Delete, Rename or Edit the 
viewer. 
Use Add Viewer at the bottom of the sidebar to create 
a new viewer. 

Pages
Each viewer lists the Home Page with each Viewer 
Page created for the viewer under it. 
Clicking a Home or Viewer Page on the sidebar opens 
a new tab where the page can be edited.
Right-click a page to Delete, Rename, or Copy the 
page and paste it to another Viewer within the same or 
a different project file. The Copy function replicates the 
page’s visual design without its configurations.
The Home Page cannot be deleted.
Use Add Page at the bottom of the sidebar to add a 
page to the viewer. 

Resolution Use this drop-down menu to set a custom screen resolution for the 
mobile device being used to control hardware devices. This option 
becomes available when you select one of the Custom selections 
from the Type drop-down menu. The Display Aspect Ratio menu 
is only provided as a reference and can not be set.

Home Page Sets the layout for the Viewer’s home page:
Blank: Creates a custom home page that you design from 
scratch.
ATEN Theme 2: Creates a home page and device page tem-
plates with graphics. Each theme provides a template that can be 
customized into your own design.

Done / Replace Click Done to edit the Viewer pages. When you click Edit 
Preferences the Replace button appears to save changes. 
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Right Sidebar
The Right Sidebar provides the Properties options which displays information and 
various settings for objects that are selected in the main window. The Properties sidebar 
will appear when a viewer page is open for editing and an object is selected. The 
Properties sidebar is discussed starting on page 87. 

Keypad
When you select the Keypad radio button on the Select Viewer page, 
configuration menus appear. The four drop-down menus allow you to 
configure the Keypad layout and ID settings. After clicking Done, the viewer 
page will open allowing you to configure the Keypad’s label and buttons. 

Type Select the type of Keypad that you are installing. 

Layout Click to define the Keypad layout. This setting should match the 
physical Keypad layout for the installation (see page 52 for details).

Controller ID Select the ID number of the Control Box (Controller) that the Keypad 
will connect through. This ID must match the controller ID Switch 
(black) set on the Keypad (see page 51).

Keypad ID Select the ID number to match the Keypad ID Switch (blue) set on 
the Keypad (see page 51). Up to 8 Keypads can connect to one 
Control Box.

Add Keypad Click Add Keypad to add another Keypad that will connect to the 
same Control Box and control the same set of devices. 

Done / Replace Click Done to edit the Viewer page for the Keypad. When you click 
Edit Preferences, the Replace button appears to save changes.
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Page Overview
When you select Mobile Device or Keypad on the Select Viewer page and 
click Done, Page Overview appears with a preview of the viewer pages that 
control the hardware. From here you can edit and delete pages created for the 
viewer profile. 

Edit and add pages to design the layout that will be used to control hardware 
from a mobile device or keypad. Each page can be fully customized with 
macros and buttons to control different hardware devices and with any object, 
background, size, shape and color of your choice. For keypads, a layout will be 
automatically created allowing you to configure the labels and buttons. 

Page Overview Shows the Home Page and each Control Page that you add to the 
Viewer.

Duplicate Click Duplicate to create a copy of the selected viewer and its 
pages. A new viewer will appear in the left sidebar. 

Edit Preferences Click Edit Preferences to enter the Select Viewer page (see 
page 95). This allows you to change the viewer’s basic settings. To 
return to Page Overview, click Done. 
Click the Edit icon to customize a viewer page (see page 99).

Click this icon to delete the viewer page. The viewer’s Home Page 
can not be deleted. 

Add Viewer Click Add Viewer from the left sidebar to create a new viewer.
Add Page Click Add Page from the left sidebar to add a new page to the 

viewer. Pages can only be added to Mobile Device viewers. 
Viewer Sidebar See Left Sidebar, page 96, for details. 
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Edit
Clicking the Edit icon of a viewer page (see page 98) allows you to customize 
the layout and design. You can add buttons*, labels, images, scroll view 
windows, and slider bars to the page. 

Buttons can be made into a Link, Macro or Function (page 111). 

Use the Library on the Project Bar to design the layout and buttons using 
Graphics (page 131); or configure Flags (page 134), Monitors (page 136) and 
Macros (page 133) for button actions. Objects can be layered, images can be 
imported and labels can be applied anywhere. 

Note: The Windows OS has a limitation when adding buttons to viewer pages 
for use on Windows mobile devices. See Windows OS Button 
Limitation, page 100, for details.

Right click on the page to add an object: Button, Label, Image, Scroll 
View, Video, Slider Bar, PowerPoint Control, and Media Control 
Template.
Select an object to open Properties on the right side. 
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Select a button or slider bar to open Action on the bottom. 
Drag and drop objects anywhere on the page. 
Right click on an object to set Order options to layer objects.
Click the mouse wheel to zoom the page in or out.
Click the Library icon on the Project Bar to open the Graphic, Flag, 
Monitor or Macro libraries.
Select and right-click multiple objects to Group or Align objects.
Use the View menu options to select Show Grid and Align to Grid to set 
objects in perfect alignment. 

Windows OS Button Limitation 
When adding buttons to a viewer page for use on a Windows mobile device 
there is a Windows OS limitation for overlapping buttons. When two buttons 
are layered (A) on top of (B), the top most button (A) can not be pressed – 
instead (B) is activated each time. To resolve this issue, duplicate the top most 
button (A) and add it (C) directly under (A) and below (B) on the viewer page. 

When the top button (A) is pressed, the lowest button (C) will execute the 
action. 
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Page Objects
A number appears at the top right corner of each object. The numbers are 
assigned in sequence, in the order that the object is added. These numbers help 
identify a label when configuring a Change Label (page 125) or a button when 
configuring a Change Button State (page 124). 

Each button has a symbol in the top left corner to indicate: 
“A” the button’s actions are configured correctly. 
“!” the button’s actions need to be modified or they will not work. 
Buttons with no symbol indicate that functions have not been added to it. 
For details on adding functions, see Button / Slider Bar Action, page 111. 

Properties
The Properties side bar provides aliment buttons for when multiple objects are 
selected allowing you to arrange them accordingly:
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Page Properties
The Page properties provides an option to change the background image. 

Style – click the Normal box to import an image (*.png,*.jpg*.jpeg*.bmp) 
to use as the background for the page. 
Position and Size – displays the Width and Height of the page according 
to the Resolution set in the Viewer Properties. This option can not be 
changed. 
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Button Properties
The Button properties provide options to configure the appearance of a 
button, and the confirmation message and progress message before 
carrying out the associated action. 

Mode 
Use this drop-down menu to select one of the following button types. 

Normal – This is a button that stays the same when pressed.
Toggle – for a button that switches between two images/colors to 
indicate the button status. This also splits the Commands list under 
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Button Action (page 111) – to provide two commands for the button: 
Toggle ON and Toggle OFF. 
Press and Release – for a button that switches between two images/
colors when pressed and released.This splits the Commands list under 
Button Action (page 111) to provide two commands for the button: 
Press and Release. 
Long Press for a button that switches between two images/colors 
when pressed and released. This button continuously re-sends a 
command to a device as long as it is pressed, at the Interval specified 
(see Interval, below) and stops sending the command once the button 
is released. 
Use the Normal and Pressed option to set the image or color of the 
button according to its state.

Appearance
Click the Appearance tab to configure the look of the button.

Note: The Appearance settings are applicable to all button modes. 
However, the Appearance tab only exists for Normal and Toggle buttons 
to categorize different sets of settings.

Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the viewer page).
Font – use the drop-down menu to select the font type. 

Color – use the drop-down menu to change the color of the text.
Size – enter a number (1-200) to set the size of the text for the 
button.
Format – formats text to Bold, Italic or Underline for the button. 
Alignment – click a box to align the text Right, Center or Left; 
and Top, Middle or Bottom within the button box.

Style – use the drop-down menu to select the style type. 
Normal imports an image to use as the button’s standard 
background and click Pressed to import an image to use when the 
button is pressed.
Color allows you to use drop-down menus to select the buttons 
color for Normal and Pressed. 
Transparency – enter a number (0-100) or use the slider-bar to 
set the transparency of the button.
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Send Command Every (Long Press mode buttons only) – use the 
drop-down menu to select the amount of time between each command 
that is sent (repeatedly) to the device while the button is pressed.
Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. Click Reset 
Image Size to reset the button size.
Restrict access to this button on ATEN Control System App with a 
password: Limit the use of the selected button by requesting a 
password when the button is tapped in the Viewer. To enable this 
function, click this option and type the password in the box below. 

Note: This function is only supported by the Normal and Toggle mode 
buttons (page 103).

Dialog
Click the Dialog tab to set up a confirmation message that displays in the 
viewer when the button is pressed. 

Note: The Dialog settings are only available for Normal and Toggle 
buttons. 

Confirm the associated action with the following message when the 
button is pressed – Click the check box to enable this feature.
Action – Select a button action (Toggle On or Toggle Off) to display 
the confirmation message.
Content drop-down list – Select one of the following for 
customization.

Background – Customize the wording for the confirmation 
message. Type the message in the Name field and optionally 
customize its font and style.
OK – Customize the wording on the button for carrying out the 
associated action. Type in the Name field and optionally 
customize its font and style.
Cancel – Customize the wording on the button for canceling the 
associated action. Type in the Name field and optionally 
customize its font and style.

Message
Click the Message tab to set up a progress message that displays while the 
associated action is being carried out.

Note: The Message settings are only available for Normal and Toggle 
buttons. 

Confirm the associated action with the following message when the 
button is pressed – Click the check box to enable this feature.
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Action – Select a button action (Toggle On or Toggle Off) for 
displaying the progress message.
Content drop-down list – Select one of the following for 
customization.

Background – Configure the wording for the progress message. 
Type the message in the Name field and optionally customize its 
font and style.
Progress Bar – Configure the display duration (in seconds), font, 
and color of the progress indicator.

Group Properties
You can unify the properties of two or more control components (buttons, 
slider bars, etc.) at the same time. Depending on the elements that your 
group of components have, different properties will be open for 
configuration.Use your mouse to drag and select the components from a 
page, the properties that are open for configuration appear in the Properties 
column. 

For example, if you want to unify the text that appear on multiple buttons, 
drag and select these buttons and then configure their properties, as 
illustrated below.
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Label Properties
The Label properties provide options to change the text formatting of a 
label. 

Name – enter the text you want to use for the label or slow double-click 
the label on the Edit page.
Font – use the drop-down menu to select the font type. 

Color – use the drop-down menu to change the color of the text. 
Size – enter a number (1-200) to set the size of the text.
Format–  format text to Bold, Italic or Underline.
Alignment – click a box to align the text Right, Center or Left; and 
Top, Middle or Bottom within the label box.

Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 
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Properties for Slider Bars
The Slider Bar properties provide options to configure a Slider Bar. Right 
click on a viewer page and select Slider Bar to add a bar. A Slider Bar can 
control a device, link to another page, or run a macro. The Slider Bar 
properties are discussed on the next page. 
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Mode – use the drop-down menu to select the button type: 
Basic Slider Bar for a bar where you enter the minimum and maximum 
values to calculate the range and levels on a slider bar, and then add 
one command to configure the Basic Slider Bar’s action (See Slider 
Value, page 117). Choose options under Value to configure the slider 
bar’s range:

ASCII / HEX – click a radio button to select the format for the 
slider bar values. 
Minimum – enter the lowest level on the bar.
Maximum – enter the highest level on the bar. 
Level – this represents the number of levels on the slider bar. You 
can calculate the value of each level with the formula: Maximum 
Value - Minimum Value / Level = Value Per Level. The Level is 
automatically calculated according to the Minimum and 
Maximum values you enter. 

Advanced Slider Bar for a bar where you set the number of levels and 
add a command for each level in the bar (see Level, in the table, on 
page 111). Choose options under Value to configure the slider bar’s 
range:

Level – this represents the number of levels on the slider bar. For 
each level you must add a separate command in the Slider Bar 
Action – Commands list (see Level, in the table, on page 111). 

Direction – sets the bearing of the slider bar. Options are Vertical or 
Horizon. 
Style – click the drop-down menus to select the Foreground Color and 
Background Color for the slider bar.
Value 

String format – Specifies the string format for the managed device to 
ASCII or HEX.
Minimum – Sets the minimum value of the slider bar.
Maximum – Sets the maximum value of the slider bar.
Level – Sets the total number of levels for the slider bar.

Position and Size – depending on whether the bar is set Vertical or 
Horizontal you can use either the Size: Width or Height box to enter a 
number to resize the length of the slider bar. 
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Properties for PowerPoint Control Templates and Media 
Control Templates
Click a PowerPoint control template or a media control template to 
configure its position, size, and the PC that controls it.

Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 
Select Device – Select the PC that stores the PowerPoint or media files 
using the drop-down list.
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Button / Slider Bar Action

The Button Action is used to set what a button does when pressed. Select a 
button on the viewer page to configure the Button Action. Use the table below 
for an overview and the instructions on the next page to add Commands and 
Advanced Options to a button’s action. 

Device Lists the devices and advanced options that can be selected to add 
commands to the Button Action. When one is selected, commands 
appear in the Function list. The upper box lists hardware, the lower 
box Advanced Options.

Room Select the room that the viewer will control devices in. Use this 
drop-down menu to select rooms in the KNX system and display 
KNX devices. The viewer will only upload to a Control Box 
configured with the same Room name (see Left Sidebar, page 84). 
Select All Rooms to allow the viewer to control all rooms. Selecting 
All Rooms will upload the viewer profile to all Control Boxes. 
The Accessible Room defines what Devices are available to 
configure new Actions in Button Properties (see page 111). Only 
Devices listed under the same Room (see page 84) as the viewer’s 
Accessible Room will be listed for use in Button Properties. 

Function Lists commands that can be added to the Commands list. When a 
device or option is selected, commands in the Function list can be 
added to the Commands list to configure the button’s action(s).

Commands Lists the commands that will initiate when the button is pressed. 
Device and Advanced Option functions can be added and 
associated in the Commands list together. Commands initiate in the 
order that they are added to the list. Right-click in the Commands 
list to use the menu selections: Move Up, Move Down, Copy, 
Paste, Delete, Save as Macro, or Test Tool. 

Toggle ON / 
Toggle OFF
or 
Press / Release

When the Button Mode (page 103) is set to Toggle or Press and 
Release, the Commands list splits to set the two c commands:
Toggle ON / Press – lists the commands that initiate when the 
button is first pressed or pressed and held.
Toggle OFF / Release – lists the commands that initiate when the 
button is pressed a second time (Toggle), or released (Press and 
Release). When the button is pressed again, Toggle ON initiates 
and the cycle repeats.
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The Level drop-down menu appears when an Advanced Slider Bar 
is selected on the viewer page. The number of levels in the drop-
down menu reflect the Level set in the Advanced Slider Bar’s 
properties (page 109). Use the drop-down menu to select a level 
and then add a command for each of the Advanced Slider Bar’s 
levels (see page 117 for details).
Use Move up to move an action up in the Commands list, or Move 
down to move an action down in the Commands list. 

Use Delete to remove an action from the Commands list. 

Use Save as Macro to save the commands in the Commands list 
as a macro. 

Use Test Tool to connect to a Control Box and test the action(s) in 
the Commands list. 
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Adding Commands

The Button Action section allows you to add and configure commands – to set 
what a button does when pressed. You can configure a button with Device 
commands (On, Off, Stop, Play, etc.); as a Macro to send multiple commands 
to one or more devices; or as a Link to other viewer pages. Advanced Options 
allow you to add conditions to the commands, as described on the next page. 

To add a command to the button:

1. Under Device, select a Room and then an option.

2. Select a command from the Function list.

3. Double-click the command to add it to the Commands list.

The commands listed under Function depend on which option is selected 
in the Device list.

4. Use the information below to understand how each Button / Slider Bar 
Action section works and how to add Advanced Option to commands.

Device – lists hardware devices and advanced options that can be 
selected to add commands to the Commands list. Commands appear in 
the Function list. Only hardware devices from the Room that is 
selected (via the drop-down menu) are listed here. The controller is 
listed first and allows you to add Special commands, as explained 
under Function, on page 115. In addition to hardware device 
commands, you can add options: 

Macro – sends multiple commands to one or more devices. Select to 
add a macro command from the Function list. To create a macro, add 
multiple device actions to the Commands list, then click the Save as 
Macro  icon or access the function by clicking the Library icon 
(page 133).
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Link – makes the button into a link that directs you to a viewer page. 
Select to add a page link from the Function list. Double-click the 
page link in the Commands list to select a different page link.

Below lists Advanced Options that provide features to add conditions 
to button commands. For more information on these options, see 
Advanced Options, page 117.

Set Variable – creates a variable for a device setting (e.g. volume) 
that is controlled by two or more UI components (e.g. slider bar or 
buttons) in the viewer. When the device setting is changed through 
one of the components, its setting is automatically synced and 
reflected on all components. For details, see Synced Variables, 
page 151.

Set Flag – sets a flag value to represent the new device status when a 
command changes a device setting. Set Flags are added to the 
Commands list after device commands to change the Flag (device 
status).

Condition – adds one or more conditions that must be met for 
commands to initiate. The conditions can be based on a variable or a 
feedback value (setting value sent from a managed device). 

Variable conditions – Use variable conditions for the controller to 
carry out actions (commands) when the specified variable value 
meets the specified conditions. Use Variable If, Variable Else If, 
and/or Variable Else to fully cover all scenarios in your 
application. For example, if you want a display a warning 
message on the Viewer when the volume of a speaker is at its 
maximum (10 dB), you will need to: (a) Set up a variable for the 
speaker volume (page 151); (b) Select a Variable If condition; (c) 
Double-click the condition to set the variable value to 10; (d) 
Drag a Change Label command and nest it under the condition 
you selected in step (a); (e) Double-click the Change Label 
command to type the warning message you wish to display when 
the speaker volume reaches 10 db.
Feedback conditions – Use feedback conditions for the controller 
to carry out actions (commands) when the specified feedback 
value meets the specified conditions. Use Feedback If, Feedback 
Else If, and/or Feedback Else to fully cover all scenarios in your 
application.

Note: The Else If and Else conditions can only be nested under the If 
conditions and can not be used on their own.
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Change Button State – this command changes the image of another 
button when this button is pressed – allowing the image of any other 
button to change when the command from this button is sent. Change 
Button State is added to the end of the Commands lists. When adding 
this to a Toggle button it allows the image to switch with the toggle 
behavior: Normal or Pressed. In this situation the Change Button 
State is added to the end of both the Toggle ON and Toggle OFF 
Commands lists.

Change Label – this option changes a label’s text with text that you 
enter manually or with text from a device’s return message. A 
Manual Change Label can be added to the beginning or end and with 
a Condition in the Commands list. Adding it to a Condition 
guarantees the label only changes when the command initiates.

Change Group Button State – this option adds a command that 
changes the button selected in a Radio Group (page 76). Create a 
Radio Group and then a Function will be listed for it when Change 
Group Button State is selected. Add the Change Group Button State 
to the Commands list of a button and use the drop-down menu to 
select the button in the Radio Group you want selected. 

Change Slider Bar Level – this option adds a command that 
changes the level of a Slider Bar (page 108). Create a Slider Bar and 
then a Function will be listed for it when Change Slider Bar Level is 
selected. Add the Change Slider Bar Level to the Commands list of a 
button and use the drop-down menus to select the Slider Bar and 
Level to change.

Function – lists the commands that can be added to the Commands 
list. Select an option under Device, then double-click or drag & drop 
commands from the Function list to add them to the Commands list. 

Associate Set Flag, Condition, Change Button State, or Change 
Label commands with device commands in the Commands list by 
dragging and dropping them into a tree view list, which allows them to 
initiate together (see Advanced Options, page 117).

If you select the controller from the Device list, you can add the Special 
commands listed below. Double-click to add, and then double-click to 
configure: 

Delay – adds a delay in seconds. Enter a number between 0.1-180. 

Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 
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DO – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

Wake on LAN – powers on the specified computer (MAC address) 
over Ethernet.

Serial Raw (ASCII) – adds a serial command in the ASCII mode.

Serial Raw (HEX) – adds a serial command in the HEX mode. 

Telnet Raw (ASCII) – adds a telnet command in the ASCII mode.

TCP Raw (ASCII) – adds a TCP command in the ASCII mode. 

TCP Raw (HEX) – adds a TCP command in the HEX mode. 

UDP Raw (ASCII) – adds a UDP command in the ASCII mode.

UDP Raw (HEX) – adds a UDP command in the HEX mode.

HTTP – adds an HTTP command.

HTTPS – adds an HTTPS command.

Commands – lists the commands that initiate when the button or slider 
bar is used. They can include Device Commands (on, off, switch, 
change setting or volume, etc.) and Conditions (Flag, Feedback) that 
must be met before a command can initiate; or Changes (Set Flag, 
Change Button State, Change Label, Change Group Button State, or 
Change Slider Bar Level) that initiate with device commands. 

When a device command has multiple values you can double-click it 
and use the Show Flag Menu* to select a device setting.

 Library Value – use the drop-down menu to 
select a device setting for the command. The selection of settings in 
the drop-down menu can be modified using the Database Generator 
to edit the command string (see Edit / Add New Device, page 155).

 Flag Variable – clicking this button allows a Flag 
with a set of values to be selected for the action. The button’s action 
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will select a setting according to the Flag value. Each value in a Flag 
can be set to a different device using a Set Flag (as a button to select 
the device). When that (Set Flag) button is pressed, the Flag value is 
set for that particular device, and will be used as the setting for this 
action, when it’s button is pressed. 

 Slider Value – select this option to configure a 
Basic Slider Bar’s command. The range and change levels are 
automatically configured according to the minimum and maximum 
values set for the Basic Slider Bar (page 108). This option only 
appears when a Basic Slider Bar is selected on the viewer page and 
you are adding Slider Bar Action commands. 

Note: The Show Flag Menu allows you to use a single Flag for all devices 
rather than adding a Conditional Flag for each device. 

 Level – When an Advanced Slider Bar is selected on 
a viewer page, the Level drop-down menu appears above the 
Commands list. A command must be added to each level of an 
Advanced Slider Bar. To configure each level, use the drop-down 
menu to select a level and then add a command to it.

Advanced Options 

Advanced Options allow you to include conditions with commands in the 
Commands list. Associate Set Flag, Condition, Change Button State or 
Change Label functions with a command in the Commands list by dragging 
and dropping them into a tree view listed with the command, so that they 
initiate in the order listed. 

Set Flag – add a Set Flag to change a Flag’s value when a command 
changes a device setting. This sets the Flag value to match the new device 
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setting (e.g. ON or OFF). Always add a Set Flag to a Condition Flag, 
after the device action(s):

To add a Set Flag:

1. Under Device, select Set Flag.

2. From the Function list, select the Flag. 

3. From the Function list, drag and drop the Flag to add it to the end of the 
Condition Flag, in a tree view list:

4. Double-click Set Flag in the Commands list to use the drop-down menus 
to set the Flag and Value. 
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Condition – adds a condition that must be met before the commands listed 
with it can initiate. When the button is pressed, the Condition's set value 
must equal the Flag or Feedback value for the command(s) to initiate. 
There are two condition types: Flag and Feedback.

Flag – adds a condition based on a Flag’s value. “If Flag equals Value” 
is true, the condition is met and the commands listed with the 
Condition will initiate. Always add a Condition Flag at the top of the 
Commands list, drag and drop the device command(s) and then a Set 
Flag at the end, in a tree view list:
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To add a Condition Flag: 

1. Under Device, click Condition.

2. From the Function list, select Flag.

3. Double-click Flag to add the Condition Flag to the Commands list.

4. Double-click the Condition Flag in the Commands list to use the drop-
down menus to set the Flag and Value. 

5. From the Function list, drag & drop device commands to add them to the 
Condition Flag, in a tree view list:
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6. Add a Set Flag after the last device command in the Commands list:

Feedback – adds a condition based on the text from a serial/telnet/
TCP device’s return message. Always add a Condition Feedback to a 
serial/telnet/TCP command, with command(s) added below the 
Condition Feedback, in a tree view list:

Receive Time – when a Feedback condition is added to a device command 
the wait to Receive Time drop-down menu appears allowing you to set the 
amount of time to wait before it stops receiving the return message from 
the device.

There are three Condition Feedback types:

Equal – when the text sent from a serial/telnet/TCP device’s return 
message matches all of the text entered for a Condition Feedback 
Equals, the commands listed below it will initiate.
Include – when the text sent from a serial/telnet/TCP device’s return 
message matches part of the text entered for a Condition Feedback 
Include, the commands listed below it will initiate.
Bypass – this option bypasses matching text from the serial/telnet/TCP 
return message and initiates a Change Label command. The label’s 
text will change to the return message sent from the device (i.e. the 
Feedback Result). A Change Label must be added to the Feedback 
Bypass for it to work.
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To add a Condition Feedback Equal/Include: 

1. Under Device, click Condition.

2. From the Function list, select Feedback.

3. From the Function list, drag and drop Feedback to add it to the Serial/
Telnet/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select equal to or include and enter the Text. 

Text entered here must match all (equal to) or part (include) of the text 
from a serial/telnet/TCP device’s return message for the command(s) to 
initiate. Use the ASCII / HEX drop-down menu to select the format. 

5. From the Function list, drag & drop device command(s) to add them to 
the Feedback Equal/Include Condition, in a tree view list:
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To add a Feedback Bypass Condition with Change Label:

1. Under Device, click Condition.

2. Select Feedback from the Function list.

3. From the Function list, drag and drop Feedback to add it to the Serial/
Telnet/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select bypass.

5. Under Device, select Change Label.

6. From the Function list, select the Viewer Page where the label is located.

7. From the Function list, drag and drop the Viewer Page to add it to the 
Feedback Bypass Condition, in a tree view list:

8. Double-click Change Label in the Commands list and use the drop-down 
menu to select a label. Labels are identified by number (see page 101).

The label’s text will change to the serial/telnet/TCP device’s return 
message. 
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Change Button State – this option is used to change another buttons 
image when this button is pressed – allowing the button image to switch 
depending on the status: Normal or Pressed. Change Button State is added 
to the end of the Commands lists and should point to a Toggle button. 
Adding this to a Toggle button allows the image to switch with the toggle 
behavior: Normal or Pressed.

To add a Change Button State:

1. Under Properties, use the Mode drop-down menu to select a button type. 

2. Under Style, click the Normal and Pressed button to select an image/
color* for the button’s state. 

Note: Use the Style drop-down menu to select Image to import an image file 
for the button state, or Color to choose a color format for the button state. 

3. Add the Toggle ON and Toggle OFF device commands to the Commands 
lists.

4. Under Device, select Change Button State.

5. In the Function list, select the viewer page.
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6. Select the Toggle ON radio button, then in the Function list, double-click 
the viewer page to add it to the end of the Toggle ON commands in the 
Commands list. 

7. Select the Toggle OFF radio button, then in the Function list, double-click 
the viewer page to add it to the end of the Toggle OFF commands in the 
Commands list.

8. In each Commands list, double-click the Change Button State command 
to set the Button and State (Normal or Pressed). 

Change Label – changes a label’s text with text that you enter manually or 
with text from a serial/telnet/TCP device’s return message (Feedback 
Result). A Change Label that uses a return message, must be added to a 
Feedback Bypass Condition (page 122). A Manual Change Label can be 
added anywhere in the Commands list. Adding it to a Condition 
guarantees the label changes only when the command initiates. 
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To add a Manual Change Label:

1. Under Device, click Change Label.

2. In the Function list, select the viewer page where the label is located.

3. Double-click or drag and drop the viewer page to add the Change Label to 
the Commands list.

4. Add a Change Label to multiple or Toggle ON / Toggle OFF Command 
lists to have the same label change text for different actions. 

5. In the Commands list, double-click Change Label to use the drop-down 
menu to select a Label and input the Text. This is the text in the label that 
will appear when the button is pushed. 

Repeat the steps to add a Change Label for the reverse action (i.g., On 
and Off). 

Change Group Button State – adds a command that changes the 
selection in a Radio Group (see page 76). To use this function, first create 
a Radio Group and then add a button to the viewer page. Add a Change 
Group Button State independently or with a device command:
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To add a Change Group Button State:

1. Under Device, select Change Group Button State.

2. From the Function list, select the Viewer Page where the Radio Group is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Group Button in the Commands list and use the 
drop-down menu to select the Button. 

Change Slider Bar Level – adds a command that changes the level of a 
Slider Bar. To use this function, first create a Slider Bar on a viewer page. 
Add a Change Slider Bar Level independently or with a device 
command:
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To add a Change Slider Bar Level:

1. Under Device, select Change Slider Bar Level.

2. From the Function list, select the Viewer Page where the Slider Bar is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Slider Bar in the Commands list and use the drop-
down menus to select the Slider Bar and Level. 
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Image Properties

The Properties for an image provide options to change and import images to 
the page. Images can be layered with other objects so that they can be placed 
as a background or as highlights for buttons (see Layering Images, page 130). 
You can Group, Order, Align, Make Same Size or Space Evenly from the 
Object menu. 

Note: For imported images, make sure the file names contain English alphabets 
and/or numerals only.

Style – shows the image selected. Click inside the box to import an image 
(*.png,*.jpg,*.jpeg,*.bmp) to the page.
Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the image selected.
Position and Size – X and Y position the image at the coordinates entered. 
Width and Height set the size of the image. 
Reset Image Size – resets the image size. 
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Layering Images
Images can be layered with other objects, such as labels and buttons, so that 
they can be placed as a background or as highlight for the page and/or other 
objects.
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Graphic Library
The Library icon on the Project bar provides a Graphics tab and drop-
down menus with ready-to-use graphics for backgrounds, buttons, 

icons and device interfaces. Device Interface provides entire page layouts that 
you can use as templates for different types of devices. Double-click or drag 
and drop graphics to add them to the page. Images can be imported for icons 
and buttons in various formats (*.png,*.jpg,*.jpeg,*.bmp). 

Background Color

Button
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Icon

Device Interface
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Library

The Library icon on the Project bar offers the following functions. The table 
below provides an overview of each function.

Flag Flags are created to include parameters when settings are changed 
to indicate the current status. For details, see Flag, page 134.

Monitor Monitors allow you to set Conditions for Digital Input (dry contact) 
and Digital Input (VDC) signals and Flags on a port that will initiate 
an Action. In addition, you can create Listen to port and Query 
port monitors which check a device’s status to initiate actions. For 
details, see Monitor, page 136.

Macro Macros initiate a sequence of actions on one or more hardware 
devices. For details, see Macro, page 148.

Schedule Click to create scheduled events. For details, see Scheduled 
Events, page 150.

Synced Variables Creates a variable for a device setting (e.g. volume) that is 
controlled by two or more UI components (e.g. slider bar or buttons) 
in the viewer. When the device setting is changed through one of 
the components, its setting is automatically synced and reflected on 
all components. For details, see Synced Variables, page 151.

+ Opens a pop-up window to create a Flag, Monitor, Macro, 
Schedule, or variable.

x Closes the Library window. 
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Flag
Flags are created for control buttons to include parameters for when 
settings are changed or requests are made to change settings on a 

device. Flags indicate what the status is and what action to take according to 
the value. Flags are added as actions to Button Properties as a Condition or Set 
Flag value. 

Conditions tell a button to initiate associated actions if the flag value is true: “If 
Flag equals Value” initiate the action. Actions are associated with a condition 
so that they only initiate if the flag value is correct. That way an ON command 
is only sent to a device if the current flag value is OFF. 

Set Flag changes the flag value when a device setting has changed. So that if a 
device is OFF and the action turns the device ON, adding a “Set Flag 1 to ON” 
will change the flag value to ON. Now the flag’s value matches the device 
status so that actions associated with flag Conditions will initiate accordingly. 

Create flags for a device and add them as a Condition and Set Flag value in the 
Action – Button Properties (see Button / Slider Bar Action, page 111). 

To create a Flag:

1. Select Flag and click +. 

2. The New Flag menu appears:

Enter a Name and select a radio button to set the flag value: 

Select On/Off and use the drop-down menu to select the Default Value. 
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Enter a range (1-100) for the values in the two boxes and use the drop-
down menu to select the Default Value. Use the drop-down menu to 
select the format ASCII or HEX. 

3. Click + to create more flags or double-click a flag to edit it. The flags will 
appear in the list, as shown below.

Name – Lists the Flag names which have been created. 

Value – Lists the flag’s values or range of values. 

Default – Lists the flag’s default value.

x – Deletes a flag from the list. 

4. Select Condition or Set Flag to add flags as a command in Button Action 
by selecting a button on a viewer page (see Button / Slider Bar Action, 
page 111). 
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Monitor
A Monitor allows you to set conditions on a port using Digital Input 
(VDC) and Digital Input (Dry Contact) signals, return messages, and 

Flags. When the condition is met, it will initiate the desired action. Digital 
Input (VDC) hardware devices provide voltage signals between 1 and 24. 
Digital Input (Dry Contact) hardware devices provide open and closed circuit 
signals. Hardware devices with return messages can be monitored using Listen 
to port or Query port conditions via text they transmit. These signals provide 
indicators from sensors or switches of an event. An event can be the 
temperature, power, dry contact, sensor, switch status, or message from a 
device. There are two parts to a monitor, the Condition and Action.

Condition & Action Overview
A monitor watches a port for a signal or message and when that message or 
signal is received – the condition is met and an action initiates. Below is an 
summary of the steps needed to create a monitor. 

To create a monitor, follow the steps below.

1. Under Device, select a monitor type. 

2. Under Status, add a device port to the Condition List. 

3. Double-click the device port in the Condition List to configure the 
condition settings. 

4. Add a device action that initiates when the condition is met. 
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The table below provides a description of the Monitor page options.

Type Use this drop-down menu to select:
If – select this option for a single condition monitor. “If” the single 
condition is met, the action initiates. 
Switch – select this option for multiple conditions that use more 
than one “If” conditions for the monitor. In this type, if one of the 
conditions is met, the monitor will initiate the action. 
Bypass – select this option to transmit device feedback message 
to the selected variable actively listening for a message or by 
receiving a return message from the specified devices.

Name Enter a unique name for the monitor. 
Query Frequency Use this drop-down menu to select how frequently the monitor 

checks a device for a signal. Options are: 100 ms - 1 second. 
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Condition This section is for adding the condition that will need to be met for 
the Action to initiate. To add a condition: 
1. Select a monitor under Device. 
2. Add a device port under Status to the Condition List. 
3. Configure the condition settings by double-clicking the device 

port in the Condition List. 
Use the Type drop-down menu to select from two condition types: 
If or Switch. Both are configured similarly, but with Switch you can 
add multiple comparison conditions called Cases, each of which 
can initiate the Action. 

Action Use this section to create the commands that will initiate when the 
monitor’s condition is met. See Button / Slider Bar Action, 
page 111, for details on configuring commands. 
Click to hide or display the Device and Status/Function columns in 
the Condition and Action lists so that you can see a complete row of 
Conditions/Commands.
Click to move an selected command up or down in the Commands 
list.

Click to remove an selected command from the Commands list. 
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Creating an If Monitor

To create a monitor for a device port with a Condition that initiates an Action, 
click + from the Library’s Monitor tab, and do the following:

1. Select IF from the drop-down menu and enter a name for the monitor. 

2. Use the drop-down menu to set the Query Frequency.

3. Use the All Conditions / Any Conditions drop-down menu to select:
These options are only for advanced setups that require multiple 
events from hardware devices connected to multiple conditions. 
Most devices only require one signal Status added to the Condition 
List to initiate an Action. Most installations will not need to use this 
option, therefore it can be ignored. 

All Conditions: Add multiple conditions – all of which must be met 
for the Action to initiate. 

Any Conditions: Add multiple conditions – one of which must be 
met for the Action to initiate. 

4. Under Device, select a Controller from the drop-down menu, and then 
choose one of the following monitor types 

Listen to port – to create a monitor that actively listens for a message 
from the device. Under Status, double-click a device port to add it to 
the Condition list.

Query port – to create a monitor that sends out a command to the 
device until a feedback message is received from the device. 

Flag – to create a flag condition for the monitor. 
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IO Input – to create a trigger signal from a device according to the 
voltage. 

5. Under Status, double-click to add a device port or flag to the Condition 
list. Then double click the device port or flag in the Condition list to 
configure the condition settings. Each is explained below:
Listen to port / Query port

(Query port only) Click F(x) to open the drop-down menu to select a 
device command to send out; or enter a command string; and then the 
click Edit Return Message icon and do as explained below.

Edit Return Message

(Listen to port / Query port) Next configure the parameters for the 
return message from the device. This message must match for the 
condition to be met. In the Condition list double-click the command 

and then click  to open the Edit Return Message window:
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Use the drop-down menu and enter a string of that will represent the 
characters in a return message from the serial device:

Select string with fixed length

Use this to set a string of characters that are set within a fixed 
parameter. Enter a string of characters and use the S to set the start of 
the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see next page) for the monitor to 
be triggered.

Select string with a non-fixed length 

Use this to set a string of characters where the parameters are 
variable. Enter a string of characters and use the S to set the start of 
the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see below) for the monitor to be 
triggered.

Drop-Down Menu

Above, enter characters that the Select string with fixed length or 
Select string with non-fixed length string must match and how they 
must be matched: Equal to, Not equal to, Include, or Exclude for 
the condition to be triggered. 

Flag 
Creates a flag condition for the monitor. Use the drop-down menus to 
set a format (how the flag value must be matched) and the flag value for 
the condition to be triggered. 
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IO Input
Create a trigger signal from a device according to the voltage. Only 
device with a Digital Input (dry contract) or Digital Input (VDC) port 
appear in the Status list. Double-click a device in the Status list to add it 
to the Condition list. Double-click the command in the Condition list to 
configure the setting:

The High or Low status tells the Monitor to initiate an Action when 
the device signal is above or below the threshold setting* for the 
port:

Digital Input (VDC)

High - states that when the voltage signal is above the Upper 
Threshold to initiate the Action.
Low - states that when the voltage signal is below the Lower 
Threshold to initiate the Action.

Digital Input (Dry Contact)

According to an open or closed circuit status for the port: 

Open - states that when the circuit is Open to initiate the Action.
Closed - states that when the circuit is Closed to initiate the 
Action. 

To configure Upper and Lower thresholds, see Click Advanced to 
configure the following parameters., page 88.

6. (Optional) Use the Operator option to add additional High or Low 
conditions (see step 4, page 139). 

7. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.
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Note: For more information on Functions, see Button / Slider Bar Action, 
page 111.

8. First select the hardware under Devices. 

9. Under Function, double-click a command to add it to the Commands list. 
This Command initiates when the Condition is met.
For details on Functions and Commands, see 

10. You can also add a Macro, Link, Set Flag or Monitor’s Condition.

11. After adding all the functions to the Commands list, the IF monitor is 
complete. 
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Creating a Switch Monitor

1. Select Switch from the drop-down menu and enter a name for the monitor. 

2. Use the drop-down menu to set the Query Frequency.

3. Use the options to create multiple condition comparisons, as explained 
below.

Type Use the drop-down menu to select:
If – select this option for a single condition comparison monitor. 
Switch – select this option for multi-condition comparisons that use 
multiple “If” comparisons for the command. 

Name Enter a unique name for the monitor. 
Query Frequency Use this drop-down menu to select how frequently the monitor 

checks a device for a signal. Options are: 100 ms - 1 second. 
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4. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.

Note: For more information on Functions, see Button / Slider Bar Action, 
page 111.

Drop-Down Menus Under the Type drop-down menu are four addition drop-down 
menus used to configure the Switch Condition: 

Controller – use the first drop-down to menu select the control-
ler for a Switch condition. 
Listen to port / Query port – use the second drop-down menu 
to select the condition type for a Switch condition (see step 4, 
page 139 for details).
Serial Device Port – use the third drop-down menu to select a 
serial device port and configure Edit Return Message (to config-
ure, see Edit Return Message, page 140).
Case – use the fourth drop-down menu to add cases by selecting 
Add More Cases for comparison that need to be met before 
monitor’s condition will initiate. In the left text box enter a name 
for the Case, in the right text box enter the character string that 
the return message should match. 

Action Use this section to create commands for the monitor. See Button / 
Slider Bar Action, page 111, for details on configuring commands.
Click this icon to switch to the Action list view so that you can see a 
complete row of the command’s functions. This is a toggle button. 

x Closes the Monitor window. 
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5. First select the hardware under Devices. 

6. Under Function, double-click a command to add it to the Commands list. 
This is the Command that initiates when the Condition is met. For details 
on what each function does, see Adding Commands, page 113.

7. You can also add a Macro, Link, Set Flag or Monitor’s Condition.

8. After adding all the functions to the Commands list, the Switch monitor is 
complete. 
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Creating a Bypass Monitor

Follow the steps below to create a bypass monitor.

1. Select Bypass from the drop-down menu and enter a name for the monitor. 

2. Configure the following settings. 
Query frequency: sets how frequently the monitor checks the device 
for a signal. Valid values range from 100 ms to 1 second.
In the second drop-down list, select one of the following:

Listen to port: actively listens for a message from the specified 
device. 
Query port: when a setting is changed on the specified device, 
the device sends a feedback message to the controller, informing 
the latest setting.

In the last drop-down list, select the port or the device to be monitored.

3. Configure the actions.

a) Select Set Variable.

b) Double-click the variable you wish to update when controller detects a 
change for the specified device setting.

c) For a variable, double-click the command and select Bypass.
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Macro
Macros allow you to create a button that will initiate a sequence of 
actions across the same or different hardware devices. This saves time 

by allowing multiple devices to initiate actions all at once from one button. For 
example, you can create a macro to start a video presentation by adding 
functions to: dim lights, power on source, power on display, lower screen and 
play source. You can also add time delays between actions in a macro. 

When you click + from the Library’s Macro tab, the window opens: 
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To create a macro:

1. Select Macro and click +. 

2. Enter a Name and select a Viewer from the drop-down menu, then click 
OK. 

3. Go to the Actions section at the bottom of the page to select hardware 
under Device and add the Function to the Commands list:

Note: For more information on adding Functions, see Button / Slider Bar 
Action, page 111.

4. After adding all the functions to the Commands list, the macro is complete.

5. In Create Viewer & Design, create a button and add a macro to the Button 
Action properties (see page 111) by selecting Macro under Devices (see 
Adding Commands, page 113 for details).
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Scheduled Events
By setting up a scheduled event, you can have a connected hardware device, 
such as an ATEN controller, perform one or a series of actions on a recurring 
schedule.

To create a new event, follow the steps below.

1. Click  and then click . 

2. Name the event.

3. Click to specify a recurring schedule for the event.

4. Configure event actions.

a) In the Device column, select a device.

b) In the Function column, double-click the desired functions. The 
corresponding commands appear in the Commands column. For details 
on what each function does, see Adding Commands, page 113.

c) In the Commands column, double-click each command to configure the 
settings.

5. Optionally add system functions. For detailed information, see Advanced 
Options, page 117.

6. These commands will initiate in the listed order. To change the order of the 
commands, click .
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Synced Variables
This feature is useful when you have two or more UI components controlling 
a single device setting. Take the example of controlling a speaker volume on a 
Viewer. You may have a slider bar, a button for maximum volume, and another 
button for minimum volume on your Viewer. When you tap the maximum 
volume button, you would like the following actions to happen:

The maximum volume button shows a toggle-on status
The minimum volume button synchronized with this setting and shows a 
toggle-off status
The slider bar synchronizes with this setting and moves to its highest 
volume

To achieve this automatic synchronization and status change, you can create a 
synced variable. A synced variable is a value holder that stores a single device 
setting (e.g. speaker volume) and can be assigned to two or more UI 
components (e.g. a slider button, a maximum volume button, and a minimum 
volume button). This way, when a device setting is changed via one of the UI 
components, the new setting will be loaded into this variable and then reflected 
by the UI components in the Viewer. 

For Devices that Return Feedback Messages

Follow the steps below to set up a synced variable if the variable (device 
setting) is for a device that returns feedback messages to the controller.

1. Create a synced variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) Click the Synced Variables  icon and then click . 

c) Configure the following settings.
Name: Type a name for the variable.
String format: Select the string format for the target device.
Setting range: Type the range for setting.
Default value: Type a default for the setting.
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Your settings may look like this:

2. Configure control components for the Viewer. For details, see Design, 
page 94.

a) In the Design tab, add control components to your Viewer. 

Note: The Synced Variable function is only applicable to toggle buttons, 
basic-mode slider bars, and radio groups of normal buttons. 
Configure the Mode setting before you proceed.

b) For a slider bar component, click it in the Viewer page and configure 
the Value settings in Properties.

c) In Properties, click Set Sync Condition and select the variable you 
created using the drop-down list.

3. Create a Monitor to set up the conditions for which the device sends its 
latest setting to the variable. For detailed steps, see Creating a Bypass 
Monitor, page 147.
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For Devices that Do Not Return Feedback Messages

Follow the steps below to set up a synced variable if the variable (device 
setting) is for a device that does not return feedback messages to the controller.

1. Create a synced variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) Click the Synced Variables  icon and then click . 

c) Configure the following settings.
Name: Type a name for the variable.
String format: Select the string format for the target device.
Setting range: Type the range for setting.
Default value: Type a default for the setting.
Select a command execution type.

Execute commands with no conditions: Execute the command 
(action) when the specified variable changes.
Execute commands with the specified conditions: Execute the 
corresponding command (action) when the variable matches. 
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2. Configure control components for the Viewer. 

a) Add a control component to the Viewer. For details, see Design, 
page 94.
Note: Make sure to configure the component mode before proceeding 
to the next step.

b) For a slider bar component, click it and configure value settings in 
Properties.

c) Click Set Variable, and then double-click the variable you created in 
step 1.

d) In Properties, click Set Sync Condition and select the variable you 
created using the drop-down list.

3. Repeat steps (a) to (d) with each of the components.If you select Execute 
commands with the specified conditions, follow the steps below to add 
commands.

a) Refer to step 4 to first configure the UI components.

b) Click Library, click the Synced Variables  icon, and then click the 
variable you created in step 1.

c) Click the drop-down list below the Execute commands with the 
specified conditions option and select a condition.

d) Add an action (command) when this condition is met. Select a device, 
double-click a desired function, and then double-click the command to 
configure the setting. 
In the case of speaker volume, when the volume changes to 0 (i.e. the 
condition is Variable = 0), the action will be “to change the speaker 
volume to 0”, as illustrated below.
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e) Repeat steps 2(c) and 2(d) to add one or more actions to each condition.

4. If you select Execute commands with no conditions, follow the steps 
below to add commands.

a) In the Device list, click to select the device. In this example, the mixer, 
840T-1(Serial), is selected.

b) Double-click the action (command) and change the value type to 
Variable Value.
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Upload

The Upload page allows you to upload viewers and/or back up projects to 
controllers.

To back up a project and its viewers to a controller:

1. Browse for the ATEN controller where you wish to save the configured 
viewers.

Auto Search: Browses for controllers on the same LAN with the 
Configurator.
Search by IP address: Use this function to browse for controllers that 
are on different LANs to the Configurator.

2. Select the Viewer files you wish to upload.
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3. Optionally click on the following to configure password authentication 
settings.

Edit Access Key: Click to change the access key required to upload 
viewers to the controller and download viewers from a mobile device.

: An access key is required to upload viewers to the controller 
and download viewers from a mobile device.

: An access key is not required to upload viewers to the controller 
and download viewers from a mobile device.

 : The access key has been changed on the controller’s web 
interface (Dashboard). To change the lock status, click on the icon and 
type the new access key to proceed.

4. Click Upload to Controller.

Note: By default, the project file is uploaded along with your selected 
viewers. To only upload the selected viewers, click Also upload 
project file to disable the function.

Viewing Controller Information
Click  to view the controller’s information.

IP Address: Displays the IP address. 
MAC Address: Displays the MAC address.
License: Displays the number of licenses available and in use. 

Select License: Allows you to load a new license file.
Reset License: Resets all license(s) in use by mobile devices. This will 
disconnect all mobile device connections to the Control Box.

Firmware Version: Displays the firmware version.
Select Firmware: Allows you to load a firmware upgrade file to update 
the firmware. 

Capacity: Displays the amount of space available for uploading viewers.
Viewers: Lists the viewers currently stored on the Control Box.

Remove Viewer: Click the trash can icon to remove the viewer stored 
on the Control Box. 

Project: Lists the project file currently stored in the controller.
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Chapter 5
Remote PC Control Using

ControlAssist

Overview

ATEN Control System allows you to control PowerPoint and media files at 
computers installed with ControlAssist, an application that grants control right 
of the target computer to the ATEN controller. With ControlAssist installed on 
a target computer, you can perform actions such as controlling PowerPoint 
slides, playing media files, and turning on a PC (via the Wake on LAN feature) 
from a Viewer on a licensed mobile device. For a complete list of supported 
function, see Supported PC Control Actions, page 168.

Specifications

Viewer
To use ATEN Viewers on a Windows platform, make sure to install 
Internet Explorer version 11 or later.

PowerPoint File Control
ControlAssist only supports PowerPoint files that contain 200 slides or 
less, and are created using Microsoft Office 2007/2010/2013, or WPS 
Office.
ControlAssist only supports the following PowerPoint file formats: 
pps, ppt, and pptx.

Media File Control
ControlAssist only supports media files created using Windows Media 
Player.
When a media file is remotely enabled and controlled using an ATEN 
Viewer, the file opens in Windows Media Player and this setting can 
not be changed.
If you encounter any issues playing a media file, try install a third-
party video codec.
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ControlAssist only supports control of the following media file 
formats: 

Category File Formats

Windows Media format asf, wma, wmv, wm

Windows Media Metafiles asx, was, wvx, wmx, wpl

Microsoft Digital Video Recording dvr-ms

Windows Media Download Package wmd

Audio Visual Interleave avi

Moving Pictures Experts Group mpg, mpeg, m1v, mp2, mpa, mpe, m3u

Musical Instrument Digital Interface mid, midi, rmi

Audio Interchange File Format aif, aifc, aiff

Sun Microsystems and NeXT au, snd

Audio for Windows wav

CD Audio Track cda

Indeo Video Technology ivf

Windows Media Player Skins wmz, wms

QuickTime movie file mov

MP4 audio file m4a

MP4 video file mp4, m4v, mp4v, 3g2, 3pg2, 3gp, 3gpp

Windows audio file aac, adt, adts
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Setting Up Remote PC Control

Follow the steps below to set up one or more computers for remote control.

1. Make sure you have installed Microsoft Visual C++ Redistributable for 
Visual Studio 2015 to the target computer. To download the package, go to 
https://www.microsoft.com/en-us/download/details.aspx?id=48145

2. Install ControlAssist to the computer you wish to control. For detailed 
steps, see Installing ControlAssist to a Computer, page 161.

3. Add the computer into the control system. For detailed steps, see Adding 
the Computer to the Control System, page 163.

4. Create a control interface to be used on a licensed mobile device. 
For detailed steps, see Configuring a Control Interface, page 165.
For details on licenses, see Licenses for Mobile Control, page 57.

Installing ControlAssist to a Computer
Follow the steps below to install ControlAssist, a program that helps to 
establish communication to ATEN controllers, to the computers you wish to 
control. 

1. Download ControlAssist.

a) Visit the ATEN download page:
https://www.aten.com/global/en/supportcenter/downloads/

b) Search for “VK6000”. A list of downloads for VK6000 appears.

c) Click ControlAssist_Vx.x.xxx.zip to download.

2. From the downloaded file, double-click ControlAssist_Setup to install 
the program. An installation wizard appears.

3. Follow the on-screen instruction to complete the installation. 

https://www.microsoft.com/en-us/download/details.aspx?id=48145
http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
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4. When the installation is complete, the ControlAssist program runs 
automatically in the system tray.
Note:

Keep the ControlAssist program enabled in the system tray to allow the 
controller to establish connection with the computer.
By default, ControlAssist uses the following connection settings. To 
change the settings, right-click  in the system tray and select 
Settings.

Setting Default Description

Username admin The credentials required for an ATEN controller 
to establish connection with the computer. 

Note: To change the username and password, 
make sure to log in the computer using an 
Administrator account.

Password password

Port 6277 The port through which ATEN Configurator 
establishes connection with the ControlAssist-
installed computer.

Session timeout 3600 The maximal time allowed for the controller to 
establish connection with ControlAssist.

Root Folder N/A This field specifies the computer path under 
which files are display in the PowerPoint 
Control and Media templates’ file list. To display 
files at the computer’s partition level, type 
%MY_COMPUTER% in this field.
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Adding the Computer to the Control System
After you have installed ControlAssist to the computer you wish to control, 
follow the steps below to establish connection between the controller and the 
target computer.

1. From ATEN Configurator, locate and open your project file.

2. Click the Device tab, and from the Ethernet device type category, click on 
a blank device or click Add More Devices to add one.

3. Click Library. This window appears.
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4. Use the search box to search for “controlassist” to load the ControlAssist 
database. This screen appears.

5. Click Add to Project. This computer, identified as a device installed with 
ControlAssist, appears in the Device Configuration List.

6. Select the newly added device and configure the Properties settings on the 
right of the interface.
Hint: For the device name, use a name that identifies the PC.

For details on Properties settings, see Properties, page 87.
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Configuring a Control Interface
Example 1:

Follow the steps below to create a control interface that allows you to browse 
and play any file from the specified root folder (see page 161) in the target 
computer. You can follow the same logic for creating a media control page.

1. In the Design tab, make sure your home page contains a presentation 
button and the viewer contains a PowerPoint page. 

2. Configure the button to have it link to the PowerPoint page if pressed in 
the Viewer.

a) Click the presentation button.

b) Select Link and then double-click the PowerPoint page.
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3. Configure the PowerPoint page if you did not use a built-in Viewer 
template. 

a) In the left sidebar, click PowerPoint.

b) In the PowerPoint page, right-click any blank spot and select 
PowerPoint Control Template. A pre-made screen is added.

c) In the Properties column, use the Select Device drop-down menu to 
select the PC that stores the PowerPoint files you want to play.



Chapter 5. Remote PC Control Using Con-

167

Example 2: 

Follow the steps below to create a quick access button for opening and playing 
a specific PowerPoint file. You can follow the same logic to create a button for 
opening and playing a specific media file. 

1. Create an outlook for the interface.

a) In ATEN Configurator, click the Design tab.

b) Click Add Page and rename the page to “presentation”.

c) Customize the interface and add control buttons using the Properties 
settings in the right-hand column. For details, see Properties, page 87.

2. Define the action of each button. For example, for the PowerPoint button to 
open and start a slide show when pressed, do the following:

a) In the preview pane, click the PowerPoint button.

b) Select ControlAssist (LAN).

c) Double-click [PowerPoint] Open file and then [PowerPoint] Start 
presentation.

d) Configure the commands and arrange them in the order of execution.
Tip: The asterisk (*) at the end of a Function indicates that it requires 
configuration in the Commands column.

For details on supported control actions, see Supported PC Control Actions, 
page 168.

3. From the Upload tab, deploy and back up the project to the controller. For 
details, see Upload, page 156.

2b

2a

2c 2d
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Supported PC Control Actions

Command Function

[Media Control] 
Note: The commands in this group apply to Windows Media Player only.

Open file Opens and plays the specified file in Windows Media 
Player.*

Play Plays the opened file in Windows Media Player.

Pause Pauses the playback.

Stop Stops the playback.

Switch Fullscreen mode Enables or disables the player to full-screen display.

Volume Adjusts the player’s volume up or down.

Switch Mute mode Enables or disables mute mode.

Switch Repeat mode Enables or disables repeated play.

Next Plays next in the playlist.

Previous Plays previous in the playlist.

Close Closes the player.

Open Playlist Opens and plays the specified playlist in Windows Media 
Player.*

Set volume to Sets the player to a specified volume.

[PowerPoint Control]
Open File Opens the specified PowerPoint file.*

Start Presentation Starts the slide show of the specified PowerPoint file.

End Presentation Ends the slide show of the specified PowerPoint file.

Close Closes the opened PowerPoint file.

Go to Next Slide Goes to the next slide.

Go to Previous Slide Goes to the previous slide.

Go to Slide Goes to a specified slide number.

Others
Shut down PC Shuts down the computer.

Open URL Opens a specified URL.

Open File Opens a specified file saved in the target computer.

Run Program Runs an application.
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Note: 
Adhere to the following guidelines when specifying file paths:

Include the file name and file extension of the target file.
Use double backward slashes between folder levels.
If the file path contains space, put the file path in double quotations. 
The following are examples of valid file paths:

“C:\\ControlAssist\\Presentation.pptx”
“C:\\ControlAssist\\Presentation Demo.pptx”
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Chapter 6
ATEN Control System App

Overview

The ATEN Control System App is a free app for mobile devices which can be 
downloaded from Google Play or the Apple App Store. The app allows you to 
download the Profiles from a Control Box. These Profiles provide the interface 
(Viewers) for remote control of hardware devices.

Installing the App

To install the ATEN Control System App on a mobile device, do the following:

1. From the mobile device, tap the App Store  or Google Play  

icon.

2. In the search box, type “aten control”.

3. Tap ATEN Control System, and then download and install the app. 

4. The ATEN Control System icon appears on the mobile device.

5. Tap the icon to open the app. 

Note: The ATEN Control System App is supported on mobile devices installed 
with Android 4.2.2 and higher, iOS9 and higher, or Windows 7 and higher.

Button Sounds
After you install the app, go to the mobile device Settings and find the ATEN 
Control so that you can enable/disable the Button Sound setting. 
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ATEN Control System App

When you open the ATEN Control System app for the first time, the default 
Welcome screen appears:

Tap Demo to try the ATEN Control System app. Tap Start to find a Control 
Box and download viewer profiles (see Welcome, page 176). 

Note: The default Welcome screen appears until a viewer profile is 
downloaded to the mobile device. After a viewer profile is downloaded, the 
default Welcome screen will reappear only if the app is reinstalled, which will 
also delete all viewer profiles. 
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Demo

The Demo page provides a preview of the ATEN Control System app with two 
sample rooms. Tap either room to view the controls of different hardware 
devices. Tap Quit Demo at the top right corner to exit.

Select a viewer profile or press any of the buttons on the Welcome page to 
demo the app. The first profile’s name will depend on the OS of the device. 

WinViewer1 / iPad / Android1

This demo shows a Conference call interface with controls for a Projector, 
Screen and Lighting. Tap any of the device icons to open the control page. 
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Control Pages

The images above show the Main page and pages for the Projector, Screen 
and Lights. 

Demo

This demo shows different buttons that can be pressed to control the Projector, 
Lights, Video Wall and Camera. Tap the icons to view control pages for each 
device. Tap the Quit Demo icon to return to the previous page, or press on the 
viewer page background until the logout dialog appears.
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Control Pages

The images above show control pages for the Projector, Lights, Video Wall 
and Camera in Demo. Tap the Home icon in the lower left corner to return to 
the previous page, or press on the viewer page background until the logout 
dialog appears.
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Welcome

The Welcome screen is the home screen of the ATEN Control System app. It 
lists the viewer profiles and provides administrative options. Tap a viewer 
profile to open the controls for a room (see Design, page 94), or use the 
administrative options listed below.

Icon Description

Edit Viewer Profile – This page provides options to add, update 
and remove viewer profiles. See page 177 for details.

Manage IP – This page provides options to configure network 
settings for Control Boxess and LAN devices. See page 178 for 
details.

Set Password – This page provides options to set a password for 
access to the Welcome page when a viewer profile is in use. See 
page 181 for details.

Log Report – This page provides an error log to troubleshoot 
connectivity issues. See page 182 for details.

Information – This page provides information about the ATEN 
Control System’s software version. See page 184 for details.
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Edit Viewer Profile
The Edit Viewer Profile page allows you to add, update and remove 
viewer profiles. To download viewer profiles, tap Add Viewer (see 

Set Password, page 181). 

Add Viewer Tap Add Viewer to download viewer profiles from the Download 
Viewer Profile page. See page 185 for details. 
Tap the Information icon to view the MAC Address, IP Address 
and Controller ID of the Control Box associated with the viewer 
profile.

Update Tap Update to connect to the Control Box and download an 
updated version of the viewer profile. After the update, the 
“Downloaded Successfully” prompt will appear

Remove Tap Remove to delete the viewer profile. A dialog box will appear to 
confirm deletion of the viewer profile. 
Tap Delete to remove the viewer profile*, or Cancel to cancel the 
deletion.
Note: Viewer profiles are only deleted on the mobile device, and 
will still be available on the Control Box. 

Done Tap Done to return to the Welcome page. 
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Manage LAN Device
The Manage LAN Device page allows you to edit network settings for 
the Control Boxes and LAN devices added in the Configurator 

software (see Device Library, page 86). 

 Tap to expand Control Boxes to view connected LAN devices.

 Tap to open the web GUI (see Browser Operation, page 53).
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Depending on the LAN device you select, different options are available.Tap 
on a device to open the settings page. Use Edit to change settings, Apply to 
save or OK to exit.

Controller

PJLink Projector 

Telnet 
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ONVIF 

TCP 

UDP
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Set Password
The Set Password page sets a password to access the Welcome page 
from a viewer profile. This prevents unauthorized users from 

changing the app settings. Users will be prompted for a password before they 
exit viewer profiles to access the Welcome page. 

Slide the Enable Password Protect button, enter a password in the box and 
tap Set. The Show Password option appears after you check enable Password 
Protect, allowing you to display the characters typed in for the password. Enter 
a number in Seconds to press before exit dialog appears to set the amount of 
time to pass when pressing on a viewer page before a window appears asking 
if you want to exit. Tap Back to exit. 
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Log Report
The Log Report page lists information and errors which can be used 
to troubleshoot issues. Tap and drag the list to scroll through the 
logs.  Tap Back to exit. 

 Tap Save to save the log file.

 Tap Report History to view saved logs (see page 183).

 Tap Delete to delete the log information.

 Tap Back to exit.
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Report History
When you tap Report History, you can view and export logs. Saved 
log files are listed by date in the left column. Tap a log file to view it 
in the window to the right. Tap and drag the list to scroll through the 
logs. Tap Back to exit.

 Tap Export to send the log as an e-mail attachment.
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Information
The Information page displays the ATEN Control System’s version.
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Download Viewer Profile

The Download Viewer Profile page allows you to search for Control 
Boxes and download viewer profiles. This page is accessed from 
Welcome → Edit Viewer Profile → Add Viewer.

Search by IP 
Address

Tap to enter a Control Box’s IP address, then tap the Search icon to 
find it. When Control Boxes are found on the network, they are 
listed in the Add Viewer box.
A Search History drop-down menu will appear for previously 
searched IP addresses. 

Auto Search Auto Search allows you to search for Control Boxes without 
specifying an IP address. The Control Box must be powered on and 
connected to the same local network. 

Add Viewer This panel lists the Control Boxes that have been found on the 
network. Each Control Box lists viewer profiles that can be 
downloaded to the mobile device. To upload viewer profiles to a 
Control Box, see Upload, page 156.

Back Icon Back returns you to the Welcome page.
Download After you select the viewer profiles you want to download, click 

Download to start the process.
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Downloading Profiles
When Control Boxes are found, they appear in the Add 
Viewer panel. Check the boxes of the viewer profiles you 

would like to download, then tap Download. 

Add Viewer The main window lists the Control Boxes that have been found on 
the network. Under each Control Box is a list of viewer profiles with 
a check box. 
Use the check boxes to select the viewer profiles you want to 
download, then click Download. If the Lock icon appears, you will 
be prompted to enter the access key. 
After viewer profiles download, the “Downloaded Successfully” 
prompt appears. Tap Done to return to the Welcome page where 
the viewer profiles will be listed. 
Note: After you download a viewer profile to the mobile device, the 
default Welcome screen no longer appears. 

Access Key When the a viewer profile requires an access key a window 
appears prompting you to enter the key. Enter the correct access 
key and then click OK to download the viewer profiles from the 
Control Box. To set the access key, see Upload, page 156. 
Tap the Information icon to view the IP Address, MAC Address 
and License information of the Control Box. The license 
information provides the total number of licenses available and the 
number in use. 
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Appendix

Safety Instructions

General
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
This product is for indoor use only.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Caution: Risk of explosion if the battery is replaced by an incorrect type. 
Always dispose of used batteries according to the proper instructions.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
To prevent damage to your installation it is important that all devices are 
properly grounded.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.



ATEN Control System User Manual

188

Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
un-interruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
Avoid circuit overloads. Before connecting equipment to a circuit, know 
the power supply’s limit and never exceed it. Always review the electrical 
specifications of a circuit to ensure that you are not creating a dangerous 
condition or that one doesn’t already exist. Circuit overloads can cause a 
fire and destroy equipment.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Make sure that all equipment used on the rack – including power strips and 
other electrical connectors – is properly grounded.
Ensure that proper airflow is provided to devices in the rack.
Ensure that the operating ambient temperature of the rack environment 
does not exceed the maximum ambient temperature specified for the 
equipment by the manufacturer.
Do not step on or stand on any device when servicing other devices in a 
rack.
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Technical Support
International

For online technical support – including troubleshooting, documentation, 
and software updates: http://eservice.aten.com
For telephone support, see Telephone Support, page iii:

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

https://eservice.aten.com

Telephone Support 1-888-999-ATEN ext 4988
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Datapoint Types

ATEN Control System (V2.3) supports the following KNX Datapoint Types 
(DPT): 

DPT ID DPT Format DPT Name

1.001 B1 DPT_Switch

1.002 B1 DPT_Bool

1.003 B1 DPT_Enable

1.004 B1 DPT_Ramp

1.005 B1 DPT_Alarm

1.006 B1 DPT_BinaryValue

1.007 B1 DPT_Step

1.008 B1 DPT_UpDown

1.009 B1 DPT_OpenClose

1.010 B1 DPT_Start

1.011 B1 DPT_State

1.012 B1 DPT_Invert

1.013 B1 DPT_DimSendStyle

1.014 B1 DPT_InputSource

1.015 B1 DPT_Reset

1.016 B1 DPT_Ack

1.017 B1 DPT_Trigger

1.018 B1 DPT_Occupancy

1.019 B1 DPT_Window_Door

1.021 B1 DPT_LogicalFunction

1.022 B1 DPT_Scene_AB

1.023 B1 DPT_ShutterBlinds_Mode

1.100 B1 DPT_Heat/Cool

2.001 B2 DPT_Switch_Control

2.002 B2 DPT_Bool_Control

2.003 B2 DPT_Enable_Control
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2.004 B2 DPT_Ramp_Control

2.005 B2 DPT_Alarm_Control

2.006 B2 DPT_BinaryValue_Control

2.007 B2 DPT_Step_Control

2.008 B2 DPT_Direction1_Control

2.009 B2 DPT_Direction2_Control

2.010 B2 DPT_Start_Control

2.011 B2 DPT_State_Control

2.012 B2 DPT_Invert_Control

3.007 B1U3 DPT_Control_Dimming

3.008 B1U3 DPT_Control_Blinds

4.001 A8 DPT_ASCII

4.002 A8 DPT_Char_8859_1

5.001 U8 DPT_Scaling

5.003 U8 DPT_Angle

5.004 U8 DPT_Percent_U8

5.005 U8 DPT_DecimalFactor

5.006 U8 DPT_Tariff

5.010 U8 DPT_Value_1_Ucount

6.001 V8 DPT_Percent_V8

6.010 V8 DPT_Value_1_Count

6.020 B5N3 DPT_Status_Mode3

7.013 U16 DPT_Brightness

8.011 V16 DPT_Rotation_Angle

9.001 F16 DPT_Value_Temp

18.001 B1R1U6 DPT_SceneControl

20.100 N8 DPT_FuelType

20.101 N8 DPT_BurnerType

20.102 N8 DPT_HVACMode

20.103 N8 DPT_DHWMode

DPT ID DPT Format DPT Name
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20.104 N8 DPT_LoadPriority

20.105 N8 DPT_HVACContrMode

20.106 N8 DPT_HVACEmergMode

20.107 N8 DPT_ChangeoverMode

20.108 N8 DPT_ValveMode

20.109 N8 DPT_DamperMode

20.110 N8 DPT_HeaterMode

20.111 N8 DPT_FanMode

20.112 N8 DPT_MasterSlaveMode

20.113 N8 DPT_StatusRoomSetp

23.001 N2 DPT_OnOff_Action

23.002 N2 DPT_Alarm_Reaction

23.003 N2 DPT_UpDown_Action

23.102 N2 DPT_HVAC_PB_Action

DPT ID DPT Format DPT Name
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Specifications

VK2100
Function VK2100

Interface Serial 4 x Programmable Bi-directional RS-232/422/
485 Ports (4 x DB9 Male Connectors, 

Configurable via Pin Assignments)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd
Flow Control: None (default) RTS/CTS

2 x Bi-directional RS-232 Ports (2 x 3-Pole 
Terminal Block Connectors)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

IR/Serial 4 x Programmable IR / Uni-directional RS-232 
Ports (2 x 4-Pole Terminal Block Connectors)

IR: TTL level (0 to 5 V)
Carrier Frequency: 10KHz~455KHz

Serial: Uni-directional RS-232 ( + - 5 V)
Baud Rate: 300 to 115200 (default: 9600)

Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

I/O 4 x Programmable Digital Input / Output 
Channels (1 x 5-Pole Terminal Block Connector)

Digital Output: 250 mA sink from 12 VDC

Digital Input:
VDC Mode 

Input Voltage Range: 0 to 24 VDC
Programmable Range: 1 to 24 VDC

Dry Contact Mode:
Pull-up 2k ohms to + 12 VDC

Relay 4 x Relay Channels (2 x 4-Pole Terminal Block 
Connector)

Normally Open, Isolated Relays
Contact Rating: Max 24 VDC, 2A

VDC 4 x 12 VDC Output Ports (2 x 4-Pole Terminal 
Block Connectors)

Power Supply: 12 VDC, 2A Max (Shared By 4 
Ports)

Connectors Ethernet 1 x RJ-45 Female, 10/100Base-T

USB 1 x USB Type A Female (White)

Power 1 x 3-prong AC power socket
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Switches Controller ID 1 x 16-Segment Switch

Power 1 x Rocker Switch

Reset 1 x Semi-recessed pushbutton

LEDs Relay 4 (Green)

IR / Serial 4 (Green)

I/O 4 (Green)

Serial RX 6 (Green)

TX 6 (Green)

Ethernet Link 1 (Green)

Act 1 (Green)

DC Output Overload 1 (Orange)

IR Learn 1 (Green)

USB 1 (Green / Orange)

Power 1 (Green)

IR Receiver 1 x IR Receiver Port

I/P Rating 100-240 VAC, 50-60 Hz

Power Consumption 40 Watt

Environment Operating Temp. 0–50ºC

Storage Temp. -20–60ºC

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 2.64 kg

Dimensions (L x W x H) 43.72 x 16.32 x 4.40 cm

Licenses for 
mobile control

No. of Free Licenses 2

Max. No. of Allowed Licenses 10

Function VK2100
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VK1100
Function VK1100

Interface Serial 2 x Programmable Bi-directional RS-232/422/
485 Ports (2 x DB9 Male Connectors, 

Configurable via Pin Assignments)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd
Flow Control: None (default) RTS/CTS

IR/Serial 2 x Programmable IR / Uni-directional RS-232 
Ports (1 x 3-Pole Terminal Block Connectors)

IR: TTL level (0 to 5 V)
Carrier Frequency: 10KHz~455KHz

Serial: Uni-directional RS-232 (0-5 V)
Baud Rate: 300 to 115200 (default: 9600)

Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

Relay 4 x Relay Channels (2 x 4-Pole Terminal Block 
Connector)

Normally Open, Isolated Relays
Contact Rating: Max 24 VDC, 2A

VDC 1 x 12 VDC Output Ports (1 x 2-Pole Terminal 
Block Connectors)

Power Supply: 12 VDC, 1A Max

Connectors Ethernet 1 x RJ-45 Female, 10/100Base-T

USB 1 x USB Type A Female (White)

Power 1 x 3-prong AC power socket

Switches Controller ID 1 x 16-Segment Switch

Power 1 x Rocker Switch

Reset 1 x Semi-recessed pushbutton

LEDs Relay 4 (Green)

IR / Serial 2 (Green)

Serial RX 2 (Green)

TX 2 (Green)

Ethernet Link 1 (Green)

Act 1 (Green)

DC Output Overload 1 (Orange)

IR Learn 1 (Green)

USB 1 (Green / Orange)

Power 1 (Green)

IR Receiver 1 x IR Receiver Port

I/P Rating 100-240 VAC, 50-60 Hz
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Power Consumption 20 Watts

Environment Operating Temp. 0–50ºC

Storage Temp. -20–60ºC

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 1.19 kg

Dimensions (L x W x H) 21.50 x 16.23 x 4.18 cm

Licenses for 
mobile control

No. of Free Licenses 2

Max. No. of Allowed Licenses 10

Function VK1100
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VK0100/VK0200
Function VK0100 VK0200

Interface Keypad Layout Up to 14 layout variations using 
4 ~ 8 buttons 

Up to 125 layout variations 
using 6 ~ 12 buttons

Serial • 2 x Bi-directional RS-232 Port (2 x 3-Pole Terminal Block 
Connector)

• Baud Rate: 300 to 115200 (default: 9600)

• Data Bit: 8 (default) or 7

• Stop Bit: 1 (default) or 2

• Parity: None (default), even or odd

Relay • 2 x Relay Channel (2 x 2-Pole Terminal Block Connector)

• Normally open, isolated Relays

• Contact Rating: Max 24 VDC, 1A

Digital Input • 1 x Digital Input Channel (1 x 2-Pole Terminal Block 
Connector); 

• VDC Mode 

 - Input Voltage Range: 0 to 5 VDC

 - Programmable Range: 1 to 5 VDC

• Dry Contact Mode 

 - Pull-up 2k ohms to + 5 VDC

Ethernet • 1 x RJ-45 Female, 10/100Base-T 

• Supported Protocol: ARP, ICMP, TCP/IP, DHCP, HTTPS, SSH 

• DHCP-enabled. The following default IP settings will be used 
if no IP is assigned within 30 seconds: 

IP: 192.168.0.60 

Subnet Mask: 255.255.255.0

Switches Controller ID 1 x 16-segment Switch

Reset Button 1 x Semi-recessed Pushbutton

Power Consumption DC5V: 1.16W; DC48V: 1.375W DC5V: 1.15W; DC48V: 
1.44W

Environmental Operating 
Temperature

0 – 50°C

Storage 
Temperature

–20 – 60°C

Humidity 0 - 80% RH, Non-Condensing

Physical 
Properties

Housing Plastic

Weight 0.35 kg (0.77 lb) 0.38 kg (0.84 lb)

Dimension 11.63 x 7.06 x 4.84 cm

(4.58 x 2.78 x 1.91 in)

8.32 x 14.76 x 4.84 cm

(3.28 x 5.81 x 1.91 in)
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Licenses for 
mobile control

No. of Free 
Licenses

0

Max. No. of 
Allowed 
Licenses

10

Function VK0100 VK0200
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Limited Warranty

ATEN warrants its hardware in the country of purchase against flaws in 
materials and workmanship for a Warranty Period of two [2] years (warranty 
period may vary in certain regions/countries) commencing on the date of 
original purchase. This warranty period includes the LCD panel of ATEN LCD 
KVM switches. Select products are warranted for an additional year (see A+ 
Warranty for further details). Cables and accessories are not covered by the 
Standard Warranty.

What is covered by the Limited Hardware Warranty
ATEN will provide a repair service, without charge, during the Warranty 
Period. If a product is detective, ATEN will, at its discretion, have the option 
to (1) repair said product with new or repaired components, or (2) replace the 
entire product with an identical product or with a similar product which fulfills 
the same function as the defective product. Replaced products assume the 
warranty of the original product for the remaining period or a period of 90 days, 
whichever is longer. When the products or components are replaced, the 
replacing articles shall become customer property and the replaced articles 
shall become the property of ATEN.

To learn more about our warranty policies, please visit our website:
http://www.aten.com/global/en/legal/policies/warranty-policy/
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